The Stellenbosch University Language Centre is a vibrant hub for students, staff and clients who require assistance with language and communication. Recognised as a world-class institution, we bring together experts in the fields of language acquisition, translation, editing, interpreting, corporate communication, research and document design. We even have a team that specialises in plain language.

We do not regard ourselves as a service provider, but rather as a partner, because we develop strong ties with our clients in the course of providing our language and communication services. We are always on the lookout for new ways to shift the boundaries of conventional communication in order to help individuals and organisations communicate effectively with their target groups. To this end we have established local and international ties with other experts in the fields of language, document design and information design.

What can we do for you?
The Stellenbosch University Language Centre is a vibrant hub for students, staff and clients who require assistance with language and communication. Recognised as a world-class institution, we bring together experts in the fields of language acquisition, translation, editing, interpreting, corporate communication, research and document design. We even have a team that specialises in plain language.

We do not regard ourselves as a service provider, but rather as a partner, because we develop strong ties with our clients in the course of providing our language and communication services. We are always on the lookout for new ways to shift the boundaries of conventional communication in order to help individuals and organisations communicate effectively with their target groups. To this end we have established local and international ties with other experts in the fields of language, document design and information design.

What can we do for you?
COMPILERS

Lenelle Foster
Celesté Fritze
Elzette Hansen
Edwin Hees
Susan Lotz
Mattie van der Merwe
Robert Young

Copyright: Stellenbosch University Language Centre © 2014
Table of Contents

Preface .......................................................................................................................... v

1. In general .................................................................................................................. 7
   1.1 Spelling .................................................................................................................... 7
   1.2 Choice of words ...................................................................................................... 8
   1.3 Tedium – but crucial – details ............................................................................... 10
   1.4 Plain language ...................................................................................................... 12

2. Addresses and telephone numbers ................................................................. 13
   2.1 Addresses – in general .......................................................................................... 13
   2.2 Capitalisation ........................................................................................................ 14
   2.3 Abbreviations ........................................................................................................ 15
   2.4 Punctuation .......................................................................................................... 15
   2.5 Telephone numbers .............................................................................................. 16

3. Abbreviations ............................................................................................................ 17
   3.1 In general ............................................................................................................... 17
   3.2 Initialisms and acronyms ...................................................................................... 19

4. Grammar ................................................................................................................... 24
   4.1 Pronouns ............................................................................................................... 24
   4.2 Gerunds .................................................................................................................. 25
   4.3 The use of ‘that’ and ‘which’ ................................................................................. 25
   4.4 The use of ‘for example’ and ‘et cetera’ ............................................................... 26
   4.5 The use of ‘firstly’ ................................................................................................. 26
   4.6 Parallelism .............................................................................................................. 27
   4.7 Wordiness .............................................................................................................. 27
   4.8 Phrases that belong together .............................................................................. 28
4.9 The use of ‘amount’ and ‘number’ .......................................................... 28
4.10 Subject-verb agreement: collective nouns ............................................. 28

5. **Capitals** ............................................................................................. 29
  5.1 In general .............................................................................................. 29
  5.2 Proper names ....................................................................................... 29
  5.3 Job titles ............................................................................................... 32

6. **Plain language and inclusive writing** .............................................. 33
  6.1 In general .............................................................................................. 33
  6.2 Pointers for using plain language ......................................................... 34
  6.3 Sex and gender .................................................................................... 34
  6.4 Sexual orientation ............................................................................... 36
  6.5 Race ..................................................................................................... 36
  6.6 Disability ............................................................................................. 37

7. **Bullets and numbers in lists** ............................................................ 39
  7.1 General ................................................................................................. 39
  7.2 Introductory elements ......................................................................... 40
  7.3 List items: capitalised or lower case? ............................................... 41
  7.4 List items: punctuation ..................................................................... 42

8. **Punctuation** ...................................................................................... 44
  8.1 Ampersand .......................................................................................... 44
  8.2 Apostrophe .......................................................................................... 44
  8.3 Colon .................................................................................................... 46
  8.4 Comma ................................................................................................ 47
  8.5 Dash ...................................................................................................... 48
  8.6 Ellipsis ................................................................................................. 49
8.7 Full stop........................................................................................................ 50
8.8 Hyphen ......................................................................................................... 50
8.9 Parentheses ................................................................................................. 52
8.10 Question mark ............................................................................................ 53
8.11 Quotation mark........................................................................................... 53
8.12 Semicolon................................................................................................... 55
8.13 Solidus/Slash ............................................................................................ 55

9. Numbers........................................................................................................... 57
9.1 General......................................................................................................... 57
9.2 Currency....................................................................................................... 59
9.3 Punctuation.................................................................................................. 59

10. Scientific writing ............................................................................................ 60
10.1 In general .................................................................................................... 60
10.2 The constituent parts of a thesis ................................................................. 61
10.3 Important detail ......................................................................................... 66
10.4 In conclusion ............................................................................................. 68

After-editing checklist .......................................................................................... 69

11. Legislation and case law .............................................................................. 70
11.1 Useful resources ........................................................................................ 70
11.2 Acts: titles and numbers ........................................................................... 70
11.3 Legislation: subsections ............................................................................ 71
11.4 Acts in a list of references ......................................................................... 72
11.5 Case law...................................................................................................... 72
12. Technical tips ................................................................. 74

12.1 The track changes function ........................................... 74

12.2 The find feature ............................................................. 75

12.3 Comments ........................................................................ 76

12.4 Formatting quotation marks ............................................ 76

12.5 Nonbreaking or hard space ............................................ 77

12.6 Automatically generated ellipsis ..................................... 78

12.7 En dash and hyphen ....................................................... 78

12.8 Page numbers ................................................................. 79

Works consulted ................................................................. 81

For further reading .............................................................. 84

Index ................................................................................. 85
Preface

The aim of the Style Guide is to provide a hands-on resource especially for language practitioners who edit, translate and proofread documents in English for the Language Centre of Stellenbosch University (SU). A separate style guide is available for Afrikaans-language usage.

The rules for correct language usage often offer more than one option for a particular writing style, and the preferences reflected in our Style Guide are those applied at the University. External clients may have different prescriptions or preferences, which we apply to their texts. The Style Guide therefore represents a selection of house rules and guidelines, not a comprehensive set of universal grammar rules.

We did consult authoritative sources in compiling the Style Guide and have indicated them in footnotes where required. We have chosen to provide the title and publication date of the source, along with the number of the rule or page concerned, in the footnote. For the full particulars of a source, please see the list of works consulted at the back.

It is important always to keep in mind the context of a rule or preference. For that purpose, we provide ample examples, highlighted against a grey background. We have also inserted tips where they seemed relevant. The Style Guide has a topical index at the back for easy reference; in the electronic version, of course, the search function provides a handy alternative.

Besides language guidelines, we have included a chapter with technical tips offering assistance with various MS Word functions.

In addition to the Style Guide, the Language Centre has an online Terminology List that may be downloaded as a PDF document. Go to http://www0.sun.ac.za/languagecentre/, click on the ‘Language Services’ tab, then on ‘Resources for Language Practitioners’ (on the right-hand side). Our ‘Resources’ web page also offers convenient links to other resources and external term lists. Do pay us a visit; you may just find a solution or a spark of inspiration.

We regard the Style Guide as a working document and will update it as regularly as possible. Please feel free to forward your comments, suggestions and enquiries to Elzette Hansen at elzetteh@sun.ac.za or call her on 021 808 9008. Alternatively, visit our website at http://www0.sun.ac.za/languagecentre/, where you will find the contact details of Language Centre staff.
1. In general

1.1 Spelling

1.1.1 Use British (UK) English rather than American (US) English unless the brief requires otherwise.

labour [NOT: labor]
traveller [NOT: traveler]
rehabilitation programme [NOT: rehabilitation program]

BUT: computer program [NOT: computer programme] (NB: ‘computer programming’ has the double ‘m’)

1.1.2 Always activate the spellchecker after you have translated or edited a document (choose UK spelling) to check for spelling, grammar or typing errors.

1.1.3 The Language Centre prefers the ‘-ise’ form of verbs and the corresponding ‘-s’ form of other parts of speech that are derived from such verbs. Generally, both the ‘-ise’ and the ‘-ize’ form are correct in British English. Certain institutions, such as Oxford University Press, opt for ‘-ize’, while others, such as Cambridge University Press, opt for ‘-ise’.

organise, organisation [NOT: organize, organization]
civilise, civilisation [NOT: civilize, civilization]

In a few exceptional cases the form with the ‘s’ is the only acceptable one.

advise
compromise
revise

---

1.1.4 Below are a few examples of well-known publishers whose names are often spelt incorrectly.

<table>
<thead>
<tr>
<th>Publisher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macmillan</td>
</tr>
<tr>
<td>McGraw-Hill</td>
</tr>
<tr>
<td>Prentice Hall</td>
</tr>
<tr>
<td>Human &amp; Rousseau</td>
</tr>
<tr>
<td>SUN MeDIA</td>
</tr>
</tbody>
</table>

1.1.5 In English, computer terms are increasingly spelt as one word. The spellings ‘website’ as well as ‘web site’ are acceptable, provided that either form is used consistently in one document. ‘Web page’, however, is always two words.

1.1.6 On compound adjectives and the question of hyphenation, see 8.8.3.

1.2 Choice of words

1.2.1 Choosing between acceptable forms

The following words have more than one form, both (or all) of which are perfectly correct. The table below indicates the Language Centre’s preferences, which are to be applied when translating. When editing, however, correctness and consistency overrule preference. Therefore, adopt our preferred form only if the source text uses another form inconsistently as well as in the minority of occurrences.

<table>
<thead>
<tr>
<th>Our preferred form</th>
<th>Other form(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-mail</td>
<td>email</td>
</tr>
<tr>
<td>internet</td>
<td>Internet</td>
</tr>
<tr>
<td>orient/oriented</td>
<td>orientate/orientated</td>
</tr>
</tbody>
</table>

1.2.2 Common tautologies

Do not use an expression that indicates a list or a range of options together with another similar expression.

The event will exhibit the models of several car manufacturers, e.g. Ford, Opel and BMW.
[NOT: The event will exhibit the models of several car manufacturers, e.g. Ford, Opel, BMW, etc.]

I absolutely detest vegetables such as onions, cabbage and squash.
[NOT: I absolutely detest vegetables such as, for example, onions, cabbage and squash.]

**NOTE:** ‘Include’ means that only some among several possibilities are mentioned; to indicate a comprehensive list, use ‘entail’, ‘comprise’, ‘consist of’ or similar expressions.

1.2.3 Bastard forms

Some words and expressions have developed out of confusion between two or more distinct forms that often differ in meaning, for example:

<table>
<thead>
<tr>
<th>Correct forms</th>
<th>Bastard form</th>
</tr>
</thead>
<tbody>
<tr>
<td>as regards</td>
<td>with regards to</td>
</tr>
<tr>
<td>with regard to</td>
<td>regarding</td>
</tr>
</tbody>
</table>
1.2.4 Different forms, distinct meanings

Careful thinking is required to distinguish the difference in meaning between different forms of some words.2

<table>
<thead>
<tr>
<th>Form A</th>
<th>Meaning A</th>
<th>Form B</th>
<th>Meaning B</th>
</tr>
</thead>
<tbody>
<tr>
<td>historic</td>
<td>a very old place or building; an event or act that is important enough to be recorded as part of history; having taken place or existed in the past; periods of time of which the history has been recorded</td>
<td>historical</td>
<td>relating to the past; connected to the study of history</td>
</tr>
<tr>
<td>economic</td>
<td>relating to trade, industry and financial management; an activity that produces enough profit for it to continue</td>
<td>economical</td>
<td>using money, time, goods, etc. carefully and without wasting any</td>
</tr>
<tr>
<td>discrete</td>
<td>separate</td>
<td>discreet</td>
<td>tactful, cautious</td>
</tr>
</tbody>
</table>

1.2.5 ‘Schedule’, ‘annexure’ or ‘appendix’?

While government departments prefer to use ‘schedule’ and ‘annexure’ in documents (i.e. for more formal texts), the Language Centre prefers ‘appendix’, especially in literary writing. The golden rule – as always – is to use one term consistently, at least within one document, and to adhere to the client’s preference.

1.2.6 ‘That’ or ‘which’? See 4.3.

1.2.7 ‘They’ or ‘their’ instead of ‘he/she’ or ‘his/hers’ (see also 6.3.3 to 6.3.5)

Although the use of ‘he’, ‘him’ and ‘his’ to denote common gender is conventionally and grammatically correct, it has come to be considered potentially sexist.3 However, the politically correct ‘s/he’, ‘him/her’ and so forth are rather clumsy,4 while there are objections to ‘he or she’ as well (sentence length and an overabundance of pronouns, for example). An option that is not yet regarded as acceptable by all editors – but which is gaining ground among standard English speakers – is the use of plural pronouns (‘their’, ‘them’ and ‘they’) instead of the singular pronoun.

---

Unless a client has clearly expressed a particular preference, the Language Centre strongly suggests that the sentence be rephrased to “make it plural, or avoid pronouns altogether”\textsuperscript{5} (see the final example in the grey block that follows).

A student learns better if he can work at his own pace. (grammatically correct, but not gender sensitive)
OR: A student learns better if he or she can work at his or her own pace.
   (gender sensitive but formulation has become cumbersome)
[NOT: A student learns better if s/he can work at her/his own pace.]

A student can move about campus quite easily if they have their own skateboard.
   (gender sensitive but problematic grammatically)
OR: Students can move about campus quite easily if they have their own skateboards.

\subsection*{1.3 Tedious – but crucial – details}

\subsubsection*{1.3.1 Time}

Time is indicated as follows according to the 24-hour clock:

\begin{itemize}
\item 06:30 [NOT: 06h30, 6.30 or 06-30]
\item 14:50 [NOT: 14h50, 14.50 or 14-50]
\item 10:00
\item 17:00
\end{itemize}

Time is indicated as follows according to the 12-hour clock:

\begin{itemize}
\item 10 am/AM
\item 5 pm/PM (no zero before a single digit)
\item 9:50 am/AM
\item 12 pm/PM is noon; 12 am/AM is midnight
\end{itemize}

\subsubsection*{1.3.2 Quotation marks – formatting}

Keep in mind the difference between smart quotes (‘…’ or “…”) and straight quotes (‘…’ or “…”): smart quotes are in the shape of the numerals ‘6’ and ‘9’ respectively. Take care to use one style of quotation marks throughout a certain document.

See \ref{12.4.3} for how to preset your computer for one style or the other.

1.3.3 Full stops in abbreviations

Full stops are not used in initials, titles, names of qualifications or headings (see 3.3.1). Do use them, though, in familiar abbreviations (see 3.3.2).

Mr Van Heerden and Prof ML Strauss shared the award.
BCom, BAHons, BSc
She applied at several universities (e.g. UP, UJ and NWU).
Practical examples (especially in Sect. 6) increase the value of this book.

1.3.4 Consistency

Whenever language is used, alternatives present themselves. Usually, the intended reader and the level of formality (i.e. the register) of the document determine the style (formal or informal; active or passive) and vocabulary. Once you have made a choice, the next step is to ensure that it is applied consistently throughout the document.

Be sensitive to authors’ choices. If they use words inconsistently, look out for an established pattern that shines through and choose the most frequently used form. When editing, do not introduce a third option or automatically choose the one you would prefer personally.

Keep to the style, vocabulary and grammatical choices you have found to be the most suitable for the intended reader and most compatible with the author's intentions. Inconsistent style and other choices not only make the author appear unprofessional; they also may confuse the reader. Please contact the Language Centre's project coordinators should you be unsure about the intended reader(s) of a certain document.

1.3.5 Titles of documents and other works

Typographically, titles are distinguished in two ways: italicisation and capitalisation.

Published works and works that may contain ‘subsections’ are generally italicised (see 1.3.5.1), while unpublished texts and texts that are components of a larger work are written unitalicised but with double quotation marks (see 1.3.5.2).

Unfortunately, capitalisation is less clear-cut. A useful rule of thumb is to use title case (capitalise all words except articles and prepositions, e.g. ‘and’, ‘or’, ‘for’, ‘with’ and ‘the’ or other ‘small words’) for the titles of books, theses, workshops and CDs. The same goes for magazines, journals, newspapers and films. Afrikaans texts tend to use sentence case (an initial capital for only the first word in the title and for proper names). The important thing is to be consistent, irrespective of the system chosen.

1.3.5.1 Italicise the following kinds of titles in any language:

Books: The Girl with the Dragon Tattoo; Die Ambassadeur; Les Misérables
CDs: Automatic for the People; Voëlvry
Newspapers, journals, magazines and radio programmes: Business Day; The Big Issue; Sports Hour
Television programmes and series, and films: Game of Thrones; The Artist
1.3.5.2 Put the following kinds of titles in double quotation marks:

Unpublished texts, whether an unpublished thesis or dissertation, paper or journal article:
“Alpha and Omega: A Study in the Trinitarian Thought of Robert Jenson”
Newspaper articles: “Pussy Riot members flee Russia” in Mail & Guardian
Brochures and pamphlets: “Guide to Astronomy”
Chapters in textbooks or other nonfiction publications: “The Profile of a Text Editor” in Text Editing
Speeches, lectures and workshops: “Academic Language and Translation Training in Europe”

Section 8.11 has more on the use of quotation marks.

1.4 Plain language⁶

Despite popular misconceptions, plain language does not equal dumbing down or simplifying a text (although the brief may include a request to simplify the text). Using plain language is an attempt to get rid of unnecessary clutter in order to make a sentence more readily understandable.

To some extent plain language is tantamount to intralingual translation – making a text accessible to a different audience.

Plain language relates not only to possible changes to lexical items, syntax and paragraphing, but also to changes in the macrostructure. This may go hand in hand with changes to the text layout. See 6.2 for a few generalised pointers on plain language.

⁶ See also ‘For further reading’.
2. Addresses and telephone numbers

2.1 Addresses – in general

2.1.1 The street number precedes the street name. The same rule applies to an apartment number, which precedes the name of the apartment building.

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>23 Andringa Street</td>
</tr>
<tr>
<td>7 Academia Court</td>
</tr>
</tbody>
</table>

2.1.2 An office or floor number is written as follows:

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room 14, Administration Building</td>
</tr>
<tr>
<td>Fifth floor, Kruinsig</td>
</tr>
</tbody>
</table>

2.1.3 Spell out ordinals for numbers one to nine (‘first’ up to ‘ninth’), but use figures for higher numbers (10 and up) along with the correct two-letter abbreviation (‘10th’). See also 2.3, about abbreviations in addresses.

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>18 Second Street [NOT: 18 2nd Street]</td>
</tr>
<tr>
<td>18 Twenty-second Street</td>
</tr>
</tbody>
</table>

2.1.4 It is unnecessary to include the name of the town in which a post office is situated.

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr DS Nel</td>
</tr>
<tr>
<td>PO Box 576</td>
</tr>
<tr>
<td>HATFIELD 0083</td>
</tr>
<tr>
<td>[NOT: Dr DS Nel]</td>
</tr>
<tr>
<td>PO Box 576</td>
</tr>
<tr>
<td>Hatfield PRETORIA 0083</td>
</tr>
</tbody>
</table>

2.1.5 Where different places share the same name, do not add the province to the address on the envelope, because the postal code will direct the letter correctly. The province may, however, be included in a sentence.

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>She lives in Heidelberg, Western Cape, where she practises as a doctor.</td>
</tr>
<tr>
<td>(note the comma after ‘Western Cape’)</td>
</tr>
</tbody>
</table>
2.1.6 When a specific street name is mentioned, British (UK) English uses the preposition ‘in’, while American (US) English uses ‘on’.\(^7\)

<table>
<thead>
<tr>
<th>British (UK) English</th>
<th>American (US) English</th>
</tr>
</thead>
<tbody>
<tr>
<td>A shop in Dorp Street</td>
<td>A shop on Dorp Street</td>
</tr>
</tbody>
</table>

**BUT:** In both UK English and US English, ‘on’ is used in the phrasing ‘on the corner of Dorp Street and Andringa Street’.

2.1.7 As regards the use of ‘at’ or ‘in’ with reference to a place, a very specific place generally takes ‘at’, while a country, province, wider area, etc. generally takes ‘in’.

While cities may be regarded as wider areas (therefore requiring ‘in’), they may also be regarded as specific stopping points on a journey (requiring ‘at’).\(^8\)

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>They met at the North Pole.</td>
</tr>
<tr>
<td>A plane landed at Oliver Tambo Airport.</td>
</tr>
<tr>
<td>He grew up in Peru.</td>
</tr>
<tr>
<td>They are holidaying in Gauteng.</td>
</tr>
<tr>
<td>He lives in the Boland.</td>
</tr>
<tr>
<td>They live in Cape Town.</td>
</tr>
<tr>
<td>BUT: The bus stopped at Cape Town on the way to Langebaan.</td>
</tr>
</tbody>
</table>

2.1.8 Note the difference in meaning between ‘at’ and ‘in’ in the example below.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>She is at Stellenbosch. (i.e. she is a faculty member or a student at Stellenbosch University)</td>
</tr>
<tr>
<td>She is in Stellenbosch. (i.e. she is visiting or living in Stellenbosch)</td>
</tr>
</tbody>
</table>

2.2 Capitalisation

2.2.1 Although capital letters are used for proper names, such as street addresses, the lower case is used when referring to the plural.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>41 Ninth Street</td>
</tr>
<tr>
<td>His office is located on the corner of Brink and Rule streets.</td>
</tr>
</tbody>
</table>

2.2.2 In an address that appears on an envelope or at the top of a letter, capitalise the name of the area or post office.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr DS Nel</td>
</tr>
<tr>
<td>PO Box 576</td>
</tr>
<tr>
<td>HATFIELD 0083</td>
</tr>
</tbody>
</table>

2.2.3 The correct use of capitalisation regarding the proper names of South Africa’s nine provinces

According to section 103 of the Constitution of the Republic of South Africa, the official names of the provinces do not contain the word ‘province’. The provinces are:

---


\(^8\) Fowler’s Modern English Usage (2004:76).
2.2.4 The word ‘province’ does not take a capital unless it is part of a proper name.

The Western Cape province of South Africa is renowned for its viticulture. Both provinces, Eastern Cape and KwaZulu-Natal, were represented at the meeting. BUT: The Premier delivered her fifth State of the Province Address.

2.3 Abbreviations

2.3.1 The words ‘Street’, ‘Avenue’ and ‘Boulevard’ may be abbreviated, but only when preceded by a street name and number.

18 Crozier St. [NOT: The office is located in Crozier St.]

18 Second Street [NOT: 18 2nd Street]
18 Tenth Street [NOT: 18 Tenth Street]

2.3.2 Use the correct two-letter abbreviation (‘th’ or ‘nd’) for ‘10th’ and higher numbers, but spell out ‘first’ up to ‘ninth’.

2.3.3 The abbreviation for ‘corner’ is ‘cor.’. The expression ‘care of’ is abbreviated as ‘c/o’ (see 8.13.3). Use the full form in a sentence.

cor. Crozier and Andringa streets
BUT: The building is on the corner of Crozier and Andringa streets. (full form in a sentence)
c/o Mr Ian Smith
26 Champagne Crescent

2.4 Punctuation

2.4.1 In a sentence the elements of an address are separated by commas.

Our office is at 28 Bird Street, Stellenbosch.
2.4.2 When the full address is given in a sentence, the postal code is not preceded by a comma.

Send the applications to: SU Language Centre, Private Bag X1, Matieland 7602. Their postal address is 28 Bird Street, Stellenbosch 7600.

2.4.3 If the address is arranged on separate lines, as on an envelope or at the top of a letter, no commas or full stops are used.

Ms CA Adams
PO Box 1621
BELLVILLE
7530

2.5 Telephone numbers

2.5.1 The area code appears first, followed by the first three digits and then the remaining four digits of the phone number. Cellphone numbers are spaced similarly. Do not use any parentheses or hyphens.

011 975 6503
082 413 8467

2.5.2 Toll-free numbers may be grouped differently.

0800 40 30
0800 220 224

2.5.3 Extensions are written as follows:

021 423 6625 ext. 456
OR use the full form of the word ‘extension’

2.5.4 If the document has an international target audience or reader(s), insert the code for South Africa (+27) before the area code, and the latter appears without the zero.

+27 11 975 6503
3. Abbreviations

3.1 In general

3.1.1 As a point of departure, rather write out words in full in running text. When you do abbreviate, preferably use abbreviations that are immediately recognisable. ‘Authoritative’ dictionaries (Oxford, Cambridge, Chambers, etc.) give the best indication of common abbreviations.

3.1.2 For guidance about using a full stop or not, see 3.3.1 and 3.3.2.

3.1.3 Do not carry over part of an abbreviation to the next line.

3.1.4 Hyphens are used in abbreviations only if the full form contains them too.

| Anglo-Ir. (Anglo-Irish) |

3.1.5 Be careful of redundancy.

| HI virus [NOT: HIV virus] |

3.1.6 Do not use the endings ‘-nd’, ‘-st’, ‘-rd’ or ‘-th’ with a date, unless no month is mentioned or you are quoting another source.

| They will arrive on the 16th. [NOT: They will arrive on 16th May.] |
| Her birth date is 22 May 1987. [NOT: Her birth date is 22nd May 1987.] |

3.1.7 Latin abbreviations

Avoid them as far as possible (apart from the ones in general use, such as ‘e.g.’ and ‘etc.’). In academic texts Latin abbreviations – such as ‘cf.’ (confer) and ‘et al.’ (and others) – are more acceptable. Nonetheless, the Language Centre prefers the English equivalents. Well-known Latin expressions like ‘et al.’, ‘e.g.’, ‘i.e.’ and ‘etc.’ do not need to be italicised.

3.1.8 Time according to the 12-hour clock

The Language Centre prefers that the abbreviations ‘am’ or ‘pm’ appear in lower case without full stops, but capital letters are acceptable, too.
3.1.9 Names of days and months are abbreviated to three or four letters, with the exception of May, June and July.9


3.1.10 Definite or indefinite article?10

Acronyms (formed from the first letters of a series of other words, pronounced as a single regular word) are generally NOT preceded by a definite article.

STIAS
SANParks
UNESCO

Initialisms (formed from the first letters of a series of other words, pronounced as separate letters of the alphabet) generally DO take a definite article if (1) their full forms do and (2) they refer to organisations or institutions.

– with a definite article
the FBI (full form: the Federal Bureau of Investigation)
the SANDF (full form: the South African National Defence Force)

– without a definite article
SAA (full form: South African Airways)
MCS (full form: Matie Community Service)

Variation does occur, especially regarding media corporations, and it seems to coincide with British and American usage.

<table>
<thead>
<tr>
<th>British</th>
<th>American</th>
</tr>
</thead>
<tbody>
<tr>
<td>the BBC (the British Broadcasting Corporation)</td>
<td>NBC (even though ‘the National Broadcasting Company’ does take a definite article)</td>
</tr>
<tr>
<td>the OED (the Oxford English Dictionary)</td>
<td></td>
</tr>
</tbody>
</table>
General exception 1: Initialisms that refer to educational institutions generally DO NOT take a definite article.

UCT (even though ‘the University of Cape Town’ does take a definite article)
CPUT (even though ‘the Cape Peninsula University of Technology’ does take a definite article)

General exception 2: Initialisms that refer to substances, methods or conditions generally DO NOT take a definite article.

DDT [substance] was banned in the USA in 1972.
The unit provides training in CPR [method].
ADHD [condition] is often diagnosed when children start school.

NOTE: If an abbreviation, whether an acronym or an initialism, is used as an adjective (that is, not as a noun), it is NOT preceded by a definite article:

All NATO agencies were represented.
All CIA agents must attend the meeting. [BUT: The CIA guards its reports carefully.]

3.1.11 ‘A’ or ‘an’?

The choice between ‘a’ and ‘an’ before an abbreviation is determined by the pronunciation of the word following the indefinite article, not the spelling. Apply the normal rule: use ‘an’ before abbreviations beginning with a vowel sound and before a silent ‘h’.

an MP privilege
an RSA flag
an SMS campaign
an HIV report

The same applies in the case of numbers written in numerals instead of words:

an 11 kV cable

3.2 Initialisms and acronyms

3.2.1 Initialisms

Initialisms are widely recognised abbreviations of nouns that are not pronounceable as words. They do form a ‘word’, but are pronounced according to their alphabet names (e.g. ‘SABC’, ‘FBI’, ‘CD’ and ‘IQ’).¹¹

Initialisms are written all in capitals, without full stops or spaces.

<table>
<thead>
<tr>
<th>ANC</th>
<th>Congress of South African Trade Unions (Cosatu or COSATU)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP</td>
<td>South African Revenue Service (Sars or SARS)</td>
</tr>
<tr>
<td>SMS</td>
<td></td>
</tr>
<tr>
<td>HIV</td>
<td></td>
</tr>
<tr>
<td>TRC</td>
<td></td>
</tr>
<tr>
<td>SAB</td>
<td></td>
</tr>
<tr>
<td>USA</td>
<td></td>
</tr>
<tr>
<td>CV</td>
<td></td>
</tr>
</tbody>
</table>

3.2.2 Acronyms

Acronyms are formed from the initial letters of other words and are pronounceable as words within the normal word patterns of English, for instance ‘Aids’, ‘Unesco’, ‘laser’, ‘scuba’ and ‘radar’.12

3.2.2.1 Because of the dynamic nature of language, some abbreviations become acronyms and the use of upper or lower case may vary from one writer to the next. More than one form may be acceptable, as long as one form is used consistently in a particular text.

acquired immune deficiency syndrome (Aids or AIDS)
Congress of South African Trade Unions (Cosatu or COSATU)
South African Revenue Service (Sars or SARS)

BUT: ‘Absa’ (Amalgamated Banks of South Africa) is written only with an initial capital.13

3.2.2.2 If an acronym is not immediately recognisable or not that well-known, capitalise the acronym to avoid confusion with a regular word.

<table>
<thead>
<tr>
<th>CAD</th>
<th>computer-aided design</th>
</tr>
</thead>
<tbody>
<tr>
<td>GET</td>
<td>general education and training</td>
</tr>
<tr>
<td>WHO</td>
<td>World Health Organization</td>
</tr>
</tbody>
</table>

3.2.3 General conventions

3.2.3.1 The names of foreign organisations or political parties are preferably translated into English. Many organisations that have an established English full form nevertheless keep the foreign-language abbreviation.

… FIT, the International Federation of Translators (Fédération Internationale des Traducteurs)
… the International Association of Football Federations (FIFA)

BUT: Sometimes the foreign-language full form may be provided, too:
the German Industry Standard (DIN – Deutsche Industrie-Norm)

---

13 Policy of Absa’s office for language.
3.2.3.2 When you encounter a term that is commonly abbreviated or that you want to abbreviate, write it out and provide the abbreviation in parentheses immediately after the first instance where it appears in the text.

South African Bureau of Standards (SABS)
Stellenbosch University (SU)
computer-aided translation (CAT)
information and communication technology (ICT)

NOTE: Use an abbreviation consistently throughout the text. In long documents the full term may be repeated a few times, e.g. at the beginning of every chapter or section.

If a term appears only once in a text, do not provide the abbreviation or acronym, unless the abbreviated form is more common than the full term.

3.2.3.3 If the abbreviated form is better known than the full form, rather mention the abbreviation or acronym first, followed by the full term in parentheses.

DNA (deoxyribonucleic acid)
OBE (outcomes-based education)

3.2.3.4 The plural form of initialisms and all-capitalised acronyms do not take an apostrophe.

NGOs, CDs
SETAs
SMSs [NOT: SMSes or SMS’s; BUT: SMSed, SMSing]14

Where confusion may arise, do use the apostrophe.

Mind your p’s and q’s.
Cross your t’s and dot your i’s.

3.3 Abbreviations (initialisms and acronyms excluded)

3.3.1 Abbreviations without a full stop

3.3.1.1 Academic degrees and other qualifications

BAHons
DTh
MB,ChB (no space after the comma)

14 Collins English Dictionary (2013: ‘SMS’).
If the name of a qualification consists of two or more elements, spaces are inserted between separate elements only if the full form or one (or more) of the elements is used:

```
AdvCertEd
BUT: PGDip (Animal Sc)
```

### 3.3.1.2 Titles and initials

<table>
<thead>
<tr>
<th><strong>Singular</strong></th>
<th><strong>Plural</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ms</td>
<td>Mss</td>
</tr>
<tr>
<td>Miss</td>
<td>Misses</td>
</tr>
<tr>
<td>Mrs</td>
<td>Mmes</td>
</tr>
<tr>
<td>Mr</td>
<td>Messrs</td>
</tr>
<tr>
<td>Dr</td>
<td>Drs</td>
</tr>
<tr>
<td>Prof</td>
<td>Profs</td>
</tr>
</tbody>
</table>

(See also 1.3.3.)

LF Ackerman [NOT: L.F. Ackerman]

### 3.3.1.3 Metric symbols

Insert a space between the figure and the symbol. Do not add an ‘s’ for plural forms.

- 45 ml
- 5 kg
- 15 ºC
- 205 ℓ

**TIPS:** To ensure that the unit does not become separated when the sentence flows over to the next line, insert a hard (nonbreaking) space between the figure and the symbol.

*How to insert a hard space:* Press and hold the Ctrl and the Shift keys, then press the space bar.

The international SI symbol for ‘litre’ is a capital ‘L’ or a lowercase ‘l’. Because the small letter ‘l’ may be confused with the number 1, the symbol ‘ℓ’ is mainly used.

### 3.3.1.4 Symbols for chemical elements

- Na
- Fe
- Cl
3.3.1.5 Currency symbols

There is no space between the figure and the symbol.

| 50c  | R12,50 | US$10 |

Abbreviations for monetary amounts may appear with or without a full stop. The Language Centre prefers the form without the full stop:

R4 m OR R4 m.

3.3.2 Abbreviations with a full stop

Avoid abbreviations as far as possible in running text. Such abbreviations are handy, however, when they improve the readability of the text (e.g. in parentheses, in captions or in tables).

3.3.2.1 Write regular abbreviations in lower case, with no spaces between the letters of a word group.

| etc.  | (et cetera – and others) |
| i.e.  | (id est – that is)       |
| e.o.  | (ex officio – in official capacity) |
| e.g.  | (exempli gratia – for example) |
| f.l.t.r. | (from left to right) |

3.3.2.2 When the abbreviation is followed by a figure, add a space.

p. 5, pp. 12-15*

*See also 8.8.10 and 10.3.3.

3.3.2.3 When the abbreviation is followed by a figure that makes it function as a proper name, the abbreviation begins with a capital.

| ch. (chapter) – Ch. 5 |
| gr. (grade) – Gr. 6 |
4. Grammar

4.1 Pronouns

4.1.1 The exclusive use of ‘he’/‘him’/‘his’ or ‘she’/‘her’/‘her(s)’ as pronouns of common gender to refer to a person of unspecified sex is considered sexist and misleading (see also 6.3).

[NOT: The driver is required to clean his car’s windows.]
[NOT: The book will be of value to the student nurse preparing for her examinations.]

NOTE: The established convention for the Stellenbosch University Calendar is to use the male pronoun unless the context indicates otherwise. The Calendar does state that the female form is also implied where male pronouns occur. Some contracts stipulate explicitly that this approach is to be followed. See also 6.3.4.

The best solution to this dilemma is to use the plural form.

Drivers are required to clean their car windows.
The book will be of value to student nurses preparing for their examinations.

When the plural is completely impractical, substitute exclusively male pronouns with ‘he or she’/‘him or her(s)’/‘his or her’. This awkward construction should be a last resort.

Assist every patient as required. If he or she cannot walk on his or her own, organise a wheelchair.

4.1.2 The personal pronoun causes difficulties when the subject and object forms are confused.

It was up to Michael and me. [NOT: It was up to Michael and I.]

TIP: Remember that object pronouns (‘me’, ‘him’, ‘her’, ‘us’, ‘them’) follow verbs and prepositions. Subject pronouns (‘I’, ‘he’, ‘she’, ‘we’, ‘they’) usually precede verbs. Another handy test in the case of a compound subject, as in the example above, is to leave out the first subject: “It was up to … me” [NOT: It was up to … I].
4.1.3 Quite often the reflexive pronoun is used erroneously instead of the personal pronoun.

The task was undertaken by the manager and me.
[NOT: The task was undertaken by the manager and myself.]

**NOTE:** A reflexive pronoun is used where the subject and the direct object are the same entity (when the noun or pronoun is doing something to or for itself).

Some verbs can only be used reflexively; for example, ‘to perjure’ is reflexive, since one can only perjure oneself.

Other verbs can be used either reflexively or nonreflexively; for example, ‘to shave’: ‘He shaved (himself)’ or ‘He shaved the patient’.

It is increasingly common to use reflexive pronouns gratuitously; for example, ‘Please forward the information to myself.’ Such formulations are usually considered nonstandard and incorrect.

The reflexive pronoun may be used to reinforce the subject; for example, ‘I myself have done the very same thing’ – to emphasise that you are speaking about yourself, not someone else.

4.1.4 The antecedent of a pronoun is an earlier noun to which the pronoun refers. When using ‘this’, ‘which’ or ‘it’, make sure that the antecedent of the pronoun is clear.

The teacher addressed the students at the assembly. It was the right time for such a talk.
[NOT: The teacher addressed the students at the assembly. It took place at the right time.]

When the number of strikers who are health care workers is enumerated, the total is staggering.
[NOT: When the number of strikers who are health care workers are enumerated, it reaches staggering proportions.]

An example with ‘which’:
The official’s comment was on record. Management acknowledged the comment.
[NOT: The official’s comment was on record, which was acknowledged by management.]

4.2 **Gerunds**

A gerund is the present participle of the verb (the verbal form ending in ‘-ing’), used as a noun. The modifiers of a gerund require the possessive case:

I would appreciate you attending the meeting. [NOT: I would appreciate you attending the meeting.]

It is dependent on his signing the document. [NOT: It is dependent on him signing the document.]

4.3 **The use of ‘that’ and ‘which’**

The key to determining when to use ‘that’ or ‘which’ is in deciding whether the clause or phrase that follows is essential to defining what you mean (restrictive) or is simply parenthetical information (nonrestrictive).\(^\text{15}\)

---

A rule of thumb:
Nonrestrictive: If the information that follows is parenthetical or unessential to the meaning of your sentence, use 'which' and set off the phrase or clause with a comma.

Restrictive: When the information that follows is definitive or essential to the meaning of your sentence, use 'that' and do not set off the phrase or clause with commas.

If Shireen tells Anthea, “My colleague owns this car, which she plans to sell,” Anthea immediately knows which car is referred to without having to know that it is about to be sold. However, if Shireen tells Anthea, “My colleague owned the car that was used in the robbery,” she wants Anthea to know that the car belonged to her colleague and that it is the vehicle that was used in the robbery.

4.4 The use of ‘for example’ and ‘et cetera’
Both ‘for example’ (‘e.g.’) and ‘et cetera’ (‘etc.’) are often used unnecessarily in sentences that contain other words which essentially mean the same thing:

[NOT: The event will exhibit the models of several car manufacturers, e.g. Ford, Opel, BMW, etc.]
RATHER: The event will exhibit the models of several car manufacturers, e.g. Ford, Opel and BMW.

[NOT: I absolutely detest vegetables such as, for example, onions, cabbage and squash.]
RATHER delete either ‘such as’ or ‘for example’.

In embedded lists that end in ‘etc.’, do not add a comma after ‘etc.’:

Prof Tim Noakes believes one should cut out sugar, bread, rice, pasta, etc. when following the Banting eating plan. [NOT Prof Tim Noakes believes one should cut out sugar, bread, rice, pasta, etc., when following the Banting eating plan.]

4.5 The use of ‘firstly’
‘Firstly’ may only be used when enumerating, in which case it replaces ‘first’ in its adverbial sense, and must be followed by ‘secondly’, et cetera.

There are three good reasons for not buying the house: firstly, it is outside our price range; secondly, it is too small; thirdly, it is too near to the shopping mall.

‘Firstly’ should not be substituted for ‘first’ in any of its other adverbial uses:

When he first arrived there, he hated the public transport system. [NOT: When he firstly arrived there, he hated the public transport system.]
4.6 Parallelism

4.6.1 Make sure that parallel structures are used in the text.

In Part 1 of this guide, we will examine the basic principles of writing. In Part 2 we will discuss the merits of a good writer.
[NOT: In the first part of this guide, we will examine the basic principles of writing. In Part 2, we will discuss the merits of a good writer.]

4.6.2 Be sure to check that the syntactical pattern is repeated in the case of ‘both … and’.

He will be remembered for both his flippant nature and his exuberant style.
[NOT: He will be remembered for both his flippant nature and exuberant style.]

4.7 Wordiness

Try to avoid excessive wordiness in writing. The following examples are taken from the Editor’s Manual of the International Colleges Group (ICG):

<table>
<thead>
<tr>
<th>The question as to whether</th>
<th>Whether</th>
</tr>
</thead>
<tbody>
<tr>
<td>He is a man who</td>
<td>He</td>
</tr>
<tr>
<td>Owing to the fact that</td>
<td>Since, Because</td>
</tr>
<tr>
<td>He has been engaged in the study of</td>
<td>He has studied</td>
</tr>
<tr>
<td>It will be seen from consideration of the data in Table 2 that</td>
<td>Table 2 shows that</td>
</tr>
<tr>
<td>At an earlier date</td>
<td>Previously, Earlier</td>
</tr>
<tr>
<td>In the modern period of time</td>
<td>Currently</td>
</tr>
<tr>
<td>Of course</td>
<td>(omit)</td>
</tr>
<tr>
<td>It is interesting to note that</td>
<td>(omit)</td>
</tr>
<tr>
<td>The great majority of</td>
<td>Most</td>
</tr>
<tr>
<td>During the course of</td>
<td>During, While</td>
</tr>
<tr>
<td>It would appear that</td>
<td>Apparently</td>
</tr>
<tr>
<td>It is admitted that</td>
<td>Clearly</td>
</tr>
<tr>
<td>It is possible that the cause is</td>
<td>The cause may be</td>
</tr>
<tr>
<td>It has long been known</td>
<td>(omit)</td>
</tr>
</tbody>
</table>
4.8 Phrases that belong together

The following phrases should always be used together:

Neither … nor
On the one hand … on the other hand
Firstly, secondly, thirdly … finally
Not only … but also

4.9 The use of ‘amount’ and ‘number’

‘Amount’ refers to things that are uncountable or counted in bulk (to mean ‘quantity’, usually with nouns that have no plural). ‘Number’ refers to things that are counted individually.

She donates large amounts of money, but has a small number of friends. [NOT: There was a large amount of people at the gathering.]

**TIP:** ‘Number’ in the type ‘a number of + plural noun’ normally governs a plural verb (‘A number of banks have been victims of computer fraud’). ‘Number’ in the type ‘the number of + plural noun’ normally governs a singular verb (‘The number of MPs has increased’).

4.10 Subject-verb agreement: collective nouns

In general, the agreement between the subject and verb in a sentence requires that a singular noun (such as ‘management’, ‘board’ or ‘staff’) take a singular verb and that a plural subject (such as ‘media’ – a controversial example) take a plural verb. However, some collective nouns are singular when we think of them as groups and plural when we think of the individuals acting within the whole.

A dozen eggs is probably enough. [BUT: A dozen friends are coming over this afternoon.] The staff makes certain decisions around here. [BUT: The staff are all on holiday.]

**A NOTE ON ‘DATA’:** Being the plural form of the Latin term ‘datum’, ‘data’ is often treated as a plural noun in academic writing or writing related to science, mathematics and finance. Elsewhere, it seems that most English speakers treat it as a singular mass noun. Please keep the client’s preference in mind when deciding how to treat ‘data’ in a text, and ensure consistency throughout that text.

---

5. Capitals

5.1 In general

5.1.1 The use of capitals for emphasis is discouraged; rather use italics or bold type.

5.1.2 The Language Centre prefers minimal capitalisation. Nonetheless, use title case in the title of publications (see 1.3.5) rather than sentence case. As always, the client’s stated preference or a clear pattern in the source text is to be respected.

Graaff-Reinet During the First World War: A Socio-historical Investigation

5.1.3 A capitalised word retains its initial capital when it becomes a word element after a hyphen.

pre-VAT price
ultra pro-Russian

5.1.4 A colon is not followed by a capital in the normal, continuous sequence of a sentence, unless the text after the colon begins with a proper name or forms a separate, full sentence.\(^\text{18}\)

We need the following fishing equipment: rods, nets, hooks and sinkers.
It was more than a meeting: it was an opportunity to bond and to strategise.

Three of the top players will participate: Novak Djokovic, Andy Murray and Roger Federer. As the saying goes: All’s well that ends well.

5.2 Proper names

5.2.1 The names of any type of recognised geographical regions are capitalised.

Cape Town, the Promised Land, the Wine Route

5.2.2 Capitalise compass directions only when they denote a recognised geographical or political region, not if they are general descriptions.

5.2.3 If surnames consist of two or more separate parts, the first as well as the last part are capitalised, unless an initial or a first name precedes the surname; then only the last part is capitalised.

<table>
<thead>
<tr>
<th>First part capitalised</th>
<th>First part lower case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Van der Linde</td>
<td>Greg van der Linde, G van der Linde</td>
</tr>
<tr>
<td>De la Rey</td>
<td>Chris de la Rey, C de la Rey</td>
</tr>
</tbody>
</table>

Titles do not count for an initial or first name:

<table>
<thead>
<tr>
<th>First part capitalised</th>
<th>First part lower case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr Van der Merwe</td>
<td>Dr J van der Merwe</td>
</tr>
</tbody>
</table>

5.2.4 When surnames that consist of separate parts are used as first names, the first part of that surname begins with a capital letter if the surname-as-first-name appears first or alone. Should such a name appear after other names or initials, the first part of the surname-as-first-name begins with a lower-case letter. That is, only the last part begins with a capital, as it would have if it functioned as a regular surname.

<table>
<thead>
<tr>
<th>First part capitalised</th>
<th>First part lower case</th>
</tr>
</thead>
<tbody>
<tr>
<td>De la Rey Theron</td>
<td>Jan de la Rey Marais</td>
</tr>
<tr>
<td>Van Wyk Louw</td>
<td>NP van Wyk Louw, NP vW Louw</td>
</tr>
<tr>
<td>De Wet Botha</td>
<td>JH de W Botha</td>
</tr>
</tbody>
</table>

**NOTE:** Therefore, we write ‘Frederik van Zyl Slabbert Institute for Student Leadership Development’ (an institute at Stellenbosch University). The abbreviated form, however, is ‘FVZS Institute for Student Leadership Development’ (capital ‘V’ as part of the acronym).

5.2.5 The names of departments, divisions, faculties and so forth are capitalised; so are the words ‘department’, ‘college’, ‘office’ and ‘school’ when they form part of the official name. When such nouns are used as general denominators or in the plural form, they take the lower case.

The Department of Political Science hosted the seminar.

[<BUT:] Their political science department has a good reputation.]

He was on his way to Political Science, which is in the next building.

The Faculty of Arts and Culture is one of the largest faculties on campus.

The faculties of Arts and Social Sciences, Economic and Management Sciences, and Medicine and Health Sciences have the largest numbers of students.
NOTE: In Stellenbosch University publications ‘University’ used on its own and capitalised refers specifically to Stellenbosch University. To avoid confusion with other institutions that are also referred to, either write out the other institution’s name or use an acronym, or use a pronoun.

In Stellenbosch University publications, when words like ‘department’, ‘division’, ‘school’ and ‘centre’ are used on their own to refer to a particular department, for example, these nouns are capitalised. In casual references (i.e. where the word functions as a general descriptor instead of a placeholder term), do not capitalise words like ‘department’ when they stand alone. Where no explicit brief is provided, follow the pattern in the original document.

The Department of Journalism offers a number of postgraduate programmes. However, the Department has no undergraduate offering.
The Faculty of Theology is fifty years old this year. The Faculty is proud of what it has achieved in this time.
The Laser Research Institute is part of the Faculty of Science. The Institute offers training in laser physics.

5.2.6 The names of academic subjects and disciplines are not capitalised (except the languages, which have to be capitalised because they are proper nouns). The same goes for cultivars, animal breeds, plant varieties\textsuperscript{19} and agricultural products.

She has a journalism class tomorrow.
He is a physiology expert.

cabernet, raisin-blanc
collie, jersey cow, merino
valencia (the fruit), hubbard squash
camembert, cheddar

NOTE: Names that refer to a specific academic programme or module are capitalised.

He takes Advanced Xhosa this semester.
She enrolled for Chemical Engineering 305.

5.2.7 The point of departure regarding names of conditions and syndromes is to write them in lower case.

measles, rubella, diabetes mellitus, muscular dystrophy, acquired immune deficiency syndrome

\textsuperscript{19} For information on the correct naming of algae, fungi and plants, see the International Association for Plant Taxonomy’s publication (2012) on the correct nomenclature.
The names of conditions and syndromes are capitalised when the name begins with an acronym or proper name. The generic part of such names (e.g. ‘disease’, ‘syndrome’) remains in lower case.

- German measles
- HIV/AIDS [BUT: the HI virus]
- Alzheimer’s/Alzheimer disease
- Down’s/Down syndrome

5.2.8 Trade names, being proper names, usually are capitalised. Faded trade names (i.e. where the connection with the person with whom or the entity with which the term was initially linked has faded away) are written in lower case.

- tippex (for any correctional fluid)
- sellotape (for any adhesive tape)
- kreepy/kreepy krauly (for any pool cleaner)

When faded trade names are used as verbs, the derived verb also takes the lower case.

- tippexed
- googled
- facebooked

5.3 Job titles

5.3.1 Job titles are capitalised when they are closely linked to the incumbent’s name.

- the President of the Republic of South Africa, Jacob Zuma
- the Secretary-General of the United Nations, Mr Ban Ki-moon

5.3.2 In formal contexts, job titles can be capitalised even when they appear without the incumbent’s name.

- Prof Russel Botman, Rector of Stellenbosch University, will deliver a speech at the opening ceremony. The Rector will be delivering another speech later that day at an event where the rectors of two other universities will also be present.

5.3.3 Job titles usually appear in lower case when they follow a personal name, are used instead of a name or are used in apposition before a name.

- Jean Harlowe is a director of one of the biggest companies in South Africa. The councillor was not invited to the event. Former deputy minister Imelda Burns will be admitted later today.

5.3.4 In formal contexts, job titles may be capitalised even when they follow a personal name.

- Colin Samuels, Director of Marketing
6. Plain language and inclusive writing

6.1 In general

Plain language and inclusive writing are two distinct but, if used correctly, complementary concepts that employ the power of language in particular ways. The plain language movement strives for lucidity and, where possible, simplicity in writing. The proponents of inclusive writing argue for nondiscriminatory written work. Both concepts may be considered the opposite of political correctness.

Plain language aims to eliminate clutter – formulations that add little or no value to the text. It also focuses on the communicative needs of the target readers rather than the personal preferences of the writer or editor. The new provisions of the Consumer Protection Act (No. 68 of 2008) that came into effect in April 2011 contain plain language regulations to protect consumers from legalese and the misleading, complicated language that often accompanies transactions of all kinds. Given prominence in this way, plain language creates a fresh awareness of how language is used and puts renewed emphasis on the responsibility to use language in an accountable manner. Ideally, communication should both refrain from bias towards particular individuals or groups and avoid anaemic or verbose formulations often associated with politically correct language.

An initial step would be to write about people as individuals, not members of a stereotyped group, and continually to pose the question: What is the purpose of this text and who is supposed to be reading it? Where references to a particular group are necessary (e.g. where shared characteristics group individuals together as a population for a specific study) include only those details that are pertinent to the study and be aware of the adjectives used to describe such a group.20

The remainder of this chapter comprises a set of sensitising remarks. It is not a paint-by-numbers guide to plain language, nor is it the final word on nondiscriminatory communication (see also 1.2.7 and 1.4). Use common sense as a guideline.

20 Cf. University of Leicester’s Inclusive Writing Study Guide.
6.2 Pointers for using plain language

6.2.1 Always consider the target readers, adapting the text to their needs rather than following personal style preferences.

6.2.2 Identify the main message clearly and ensure that it is not buried in detail. Rather throw out words and details that add little value. Be ruthless about clutter.

6.2.3 Structure documents so that the most important facts are presented first (the funnel principle).

6.2.4 Pay as much attention to design and layout as to language. For example, use bulleted lists where possible or preferable, and use headings as signposts for the reader. And do not forget the power of spacing: adding white space declutters a page and improves readability.

6.2.5 Use short, familiar words where they match the meaning. Do not dress the text up with long words just to sound impressive. (See 4.7 for some examples.)

6.2.6 Use the active voice rather than the passive voice.

Please pay your bill before leaving this office.
[NOT: Bills are to be paid before the office may be vacated.]

6.2.7 Keep an average sentence length of 15 to 20 words, but vary individual sentences between 10 and 35 words.

6.2.8 As a final step, always check the text carefully for errors in spelling, grammar and punctuation.

6.3 Sex and gender

6.3.1 Sex usually refers to biology (a person may be biologically male, female or intersex), while gender may be considered a social and cultural construct (and based on individual performance). For example, an individual may be a biological male but subscribe to attributes that are associated with biological females in a particular culture (i.e. be engendered female).

6.3.2 Where possible, use ‘male’ and ‘female’ as adjectives rather than nouns.

Male respondents reported that they had trouble identifying the left-handed isotope.
[NOT: Males reported that they had trouble identifying the left-handed isotope.]

6.3.3 Do not use only the male pronouns ‘he’ or ‘his’ when the author is referring to people in general. The easiest way to make a document gender friendly is to use plurals (see 1.2.7). In some cases using plural nouns becomes tricky and the so-called ‘singular they’ is deployed (see below).

---

21 Quinion (s.a.) provides a useful summary of the various options available to any writer or editor.

22 Cf. The Chicago Manual of Style (s.a.): “Though some writers are comfortable with the occasional use of they as a singular pronoun, some are not, and it is better to do the necessary work to recast a sentence or, other options having been exhausted, use he or she. For a fuller discussion of this issue, see paragraph 5.223 in CMOS 16 and the entry for ‘he or she’ under the ‘Glossary of Problematic Words and Phrases’ at paragraph 5.220.”
Police officers should always know where their firearms are.

Someone has moved my cheese and if I find out who they are, they will be very sorry.

Recently-coined singular gender-neutral pronouns include “e”, “co” and “v” (the latter used specifically for transsexual individuals), but these are not commonly used at the time of writing. Employ with caution.

6.3.4 Some legal texts and the SU Calendar specifically state that references to one ‘gender’ (usually by means of male pronouns) should not be interpreted as applicable only to that gender, but should be seen as including ‘the other’ gender (usually women). In the case of such clear instructions, follow the client’s lead.

In this publication any expression signifying one of the genders includes the other gender equally, unless inconsistent with the context.

6.3.5 Avoid the awkward ‘he/she’ (or ‘s/he’) and ‘his/her’. If the singular form must be used, use both pronouns, joined by a conjunction (see also 1.2.7).

A police officer should always know where his or her firearm is.

If a student is ill, he or she should notify the lecturer immediately.

6.3.6 Avoid the sexist use of gender-specific titles. Gender-specific language could be used if the sex of the particular individual is known, but in most cases such usage is unnecessary.

We need to appoint a new chairperson [OR chair OR presiding officer].

[NOT: We need to appoint a new chairwoman.]

Joan Nkunzi is the chairperson [OR chair OR presiding officer] of the committee.

OR: Joan Nkunzi is the chairwoman of the committee.

6.3.7 If gendered titles must be used, be consistent. Do not single out one sex unless it serves a purpose.

As chairman of SCOPA, Themba Godi emphasised that greater accountability was needed from Maggie Maunye and Tisetso Magama, respectively chairwoman of the Portfolio Committee on Home Affairs and chairman of the Portfolio Committee on International Relations and Co-operation.

[NOT: As chairman of SCOPA, Themba Godi emphasised that greater accountability was needed from Maggie Maunye and Tisetso Magama, respectively chairwoman of the Portfolio Committee on Home Affairs and chair of the portfolio Committee on International Relations and Co-operation.]

---

23 Refer to Baron’s essay entitled “The Epicene Pronouns” (s.a.) for a reasonably exhaustive list of invented pronouns.


25 For some comments on invented gender-neutral pronouns in Swedish, see the Johnson blog (2012) in The Economist.

26 See, however, the British Colombia Law Institute’s project on gender-free legal writing.

27 Quoted from SU Calendar 2014 Part 1: 5.
6.3.8 Be both sensitive and sensible: some terms may not cause offence.

manhandle
manhole
manhunt

6.4 Sexual orientation

6.4.1 As suggested in the other sections of this chapter, reference to sexual orientation should serve a particular purpose in a particular text.

In constantly questioning heteronormativity, Denise de Ville seeks to further gay and lesbian liberation.

6.4.2 Given the connotations that have been attached to the word ‘homosexual’ in the past (i.e. the negative component in the binary pair heterosexual-homosexual), it may be advisable to use ‘gay’, ‘lesbian’ (both as adjectives instead of nouns), ‘gay man’ or ‘gay woman’ where such references are necessary or cannot be readily avoided.

6.5 Race

6.5.1 Ideally, reference to race should be unnecessary. Any reference to a particular race group should serve a purpose in the text, for example, highlighting a change in student demographics at a particular university.

6.5.2 When used as descriptors of race, the terms ‘black’, ‘white’ and ‘brown’ should be used as adjectives, not nouns, and should not be capitalised.

This year there are many black participants in the event.
[NOT: This year there are many Blacks participating in the event.]

Let the context be your guide to ensure that references to race are not unnecessary and discriminatory.

6.5.3 Stellenbosch University prefers ‘coloured’ to ‘brown’, particularly in the phrase ‘black, coloured and Indian (BCI) students’.

The policy also offers management an instrument to help ensure that diversity objectives with respect to black, coloured and Indian (BCI) students at undergraduate level can be achieved.

6.5.4 When referring to a person of Indian descent, the word ‘Indian’ is capitalised because it derives from the country of origin, namely India, which is a proper noun.

---

28 Cf. University of Colorado Boulder’s Style Guide on inclusive writing.
29 Quoted from SU Calendar 2014 Part 1:120.
6.5.5 Be careful of assumptions about race. The term ‘African’ may refer to ‘black African’ individuals in particular, or it may be a broader term that includes a number of racial groups.

In 2013 Cricket South Africa (CSA) imposed a quota on provincial cricket franchises, stipulating that provincial sides had to include one African player in the match-day eleven. A no-brainer, said the CSA, considering that Africans were the majority population group in South Africa.

The number of African students at CPUT declined markedly when compared with the number of white students. A similar trend was noticed at SU, where so-called black, coloured and Indian (BCI) students were leaving the university in droves.

Similarly, the use of ‘black’, ‘brown’ or ‘coloured’ may be a contentious issue.

Until his untimely death in 1997, Patrick Petersen was a leading light in the black Afrikaans writers’ movement, seeking to reclaim Afrikaans from white or Afrikaner writers.

“The Bruin Bemagtiging Beweging (Brown Empowerment Movement) refers to ‘coloureds’. And then you also have the Coloured Liberation Movement for the Advancement of Brown People. Somewhere,” my supervisor said, “you are going to step on someone’s toes.”

6.6 Disability

Be careful not to conflate individuals and any (medical) condition they may have.30

6.6.1 Use ‘disabled’ as an adjective rather than a noun.

Be careful when using a label to identify a particular disability. Using ‘blind’ or ‘visually impaired’ may be acceptable as descriptors, but the Deaf Federation of South Africa (DeafSA) prefers ‘deaf’ to ‘hearing impaired’, and also uses ‘deaf’ as a noun.31

Special arrangements will be made for students with disabilities.
OR: Special arrangements will be made for disabled students.
[NOT: Special arrangements will be made for the disabled.]

Blind people constitute 5% of the population in the Western Cape.
[NOT: The blind constitute 5% of the population in the Western Cape.]

6.6.2 In some cases older proper names may contain non-inclusive references to people with disabilities. Do not change the original name.

Enrol now at the Beethoven School for the Deaf!
The Institute for the Blind is located in Worcester.

6.6.3 When working with marketing material in particular, choose adjectives and adverbs that are neutral and that provide accurate descriptions of individuals and any (medical) conditions under discussion.

30 Cf. University of Leicester’s Inclusive Writing Study Guide.
31 Cf. DeafSA website.
6.6.4 ‘Disabled’ and ‘handicapped’ have different meanings. A disability is a functional limitation or restriction of an individual’s ability to perform an activity. A handicap is an environmental barrier that limits or prevents full participation or entrance. Inaccessible entrances are one example of a handicap.\(^{32}\)

There are designated parking areas for disabled people [OR: people with disabilities]. [NOT: There are designated parking areas for handicapped people.]

\(^{32}\) Cf. University of Colorado Boulder’s Style Guide on inclusive writing.
7. Bullets and numbers in lists

NOTE: All the items in a list must follow the same grammatical structure.

7.1 General

7.1.1 Do not change the layout or punctuation of a text unless it is necessary. Do make changes when:

- The list is inconsistent.

Ways to relax include:
- Go for a long walk
- Reading as much as possible
- A chat with loved ones

OR

- The list is illogical.

Popular books include:
1. The Bible

OR

- The list is difficult to read.

1.2.1.1 (i) (a) look like flies from a distance
1.2.1.1 (i) (b) has just kicked over the water bucket
1.2.1.1 (i) (c) is not included in 1.1.1.1 (iii) (cc).

7.1.2 Numbered lists (as opposed to bulleted lists) are appropriate when:

- The sequence in which the information is communicated is relevant, or the items indicate steps that must be carried out in a certain order.

Method:
1. Sift the dry ingredients into a mixing bowl.
2. Melt the butter and add slowly to the dry mixture.
3. Whip the egg whites until they form soft peaks.
OR

• The sequence of the information indicates the relative importance of the items.

For a hike of this kind, you need:
1. sturdy shoes
2. a cap
3. chewing gum

OR

• The items must be easy to locate for purposes of cross-referencing, e.g. in the Stellenbosch University Calendar.

8.2.4 All students who obtain admission to the examination (see par. 8.2.7 for examination admission) in a module are free to choose whether they want to write the first or the second examination in a module, provided that the decision to write the first examination is irreversible once the student has reported for the first examination. A student who becomes ill while writing the first examination in a module shall complete the examination session. It therefore is advisable that, if a student is ill before the first examination in a module, he should strongly consider rather writing the second examination in the module.

8.2.5 No further rounds of examination in a module, with the exception of a dean's concession examination (see par. 8.1.12), will be granted after the second examination, no matter what the reason why the examination could not be written.

AND

• Sublevels are numbered only up to level four; for subsequent levels, use Roman numerals or letters.

1.
1.1
1.1.1
1.1.1.1
1.1.1.1 (i) OR
1.1.1.1 (a)

7.1.3 Readability and the text type determine if (and how) lists are punctuated. Often the mere fact that items are presented as a list fulfils the function usually performed by punctuation marks. In such instances, or where the client prefers clean text, punctuation may be omitted. For complex or formal texts, on the other hand, punctuation often is crucial to make such texts more reader friendly. See 7.4 about punctuation.

7.2 Introductory elements

7.2.1 An introductory element helps to contextualise the list. The list follows immediately on the introductory element.
7.2.2 If the introductory element and the respective list items do not form a continuous full sentence, the introductory element is followed by either a colon or no punctuation at all.

The vendor should commit to the following:
- provide full training
- do regular maintenance work
- respond promptly to requests

Sports that are not included in the evaluation
- soccer
- cricket

7.2.3 If the introductory element and the respective list items form a full sentence, either in combination or on their own, the introductory element is followed by either a colon or a dash, or no punctuation at all.

Punctuate this type of sentences by:
- putting a semicolon after each item;
- putting a semicolon after the second-to-last item; and
- concluding with a full stop.

Punctuate this type of sentences by
- putting a semicolon after each item;
- putting a semicolon after the second-to-last item; and
- concluding with a full stop.

At the open day –
- tours were given of academic departments
- experts gave short talks
- students could visit the residences

7.3 List items: capitalised or lower case?

7.3.1 List items are capitalised when:

- Every item on the list independently forms a full sentence.

Plans for this year include the following:
- Lose two kilos.
- Neaten the garden regularly.
- Wash the car and the dog every fortnight.
- Enjoy weekends together as a family.

OR

- There is no introductory element that precedes the list.

- Use spaces to group telephone numbers.
- Remember to include the area code.
- Do not use parentheses for the area code.
- Do not use hyphens.
7.3.2 List items are in *lower case* when the introductory element together with every respective list item forms a continuous full sentence.

At the open day –
- tours were given of academic departments
- experts gave short talks
- students could visit the hostels

7.3.3 List items may be *either capitalised or in lower case* when:

- Each list item consists of a single word or concept.

<table>
<thead>
<tr>
<th>These are some of the percussion instruments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• triangle</td>
</tr>
<tr>
<td>• bass drum</td>
</tr>
<tr>
<td>• tambourine</td>
</tr>
<tr>
<td>• cymbals</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

OR

- Each list item consists of a phrase that does not form a full sentence, either independently or together with the introductory element.

<table>
<thead>
<tr>
<th>We offer the following cardiovascular exercises:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• aerobics in the main hall/Aerobics in the main hall</td>
</tr>
<tr>
<td>• rope jumping in the studio/Rope jumping in the studio</td>
</tr>
<tr>
<td>• cycling sessions in the gym/Cycling sessions in the gym</td>
</tr>
<tr>
<td>• dance lessons in the dance hall/Dance lessons in the dance hall</td>
</tr>
</tbody>
</table>

7.4 List items: punctuation

7.4.1 Where each list item independently forms a full sentence or if there is no introductory element that precedes the list:

- Every item on the list ends in a full stop.

For examples, see both instances at 7.3.1 above.

OR

- Neither the list items nor the list as a whole is concluded by any punctuation at all.

<table>
<thead>
<tr>
<th>Ways to relax include:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Go for a long walk</td>
</tr>
<tr>
<td>• Read as much as possible</td>
</tr>
<tr>
<td>• Chat with loved ones</td>
</tr>
</tbody>
</table>
7.4.2 Where the introductory element, together with every respective item on the list, forms a continuous full sentence:

- Every item on the list ends in a semicolon – except for the last item, which ends in a full stop. The second-to-last item is followed by ‘and’.

Punctuate this type of sentences by:
- putting a semicolon after each item;
- putting a semicolon after the second-to-last item; and
- concluding with a full stop.

OR

- Neither the list items nor the list as a whole is concluded by any punctuation at all.

For an example, see 7.3.2 above.

7.4.3 Where each list item consists of a single word or concept, or of a phrase that does not form a full sentence (either independently or together with the introductory element), neither the list items nor the list as a whole is concluded by any punctuation at all.

For examples, see both instances at 7.3.3 above.
8. **Punctuation**

**NOTE:** Do not italicise, bold or underline punctuation marks such as commas and full stops that immediately follow italicised, bold or underlined text. When a full sentence appears in parentheses, do not underline the full stop or the parentheses.

*(The University will close over the Easter weekend.)*

*[NOT: *(The University will close over the Easter weekend.)*]*

---

### 8.1 Ampersand

8.1.1 The ampersand is acceptable in some abbreviations and if it forms part of a company’s or a publication’s registered name.

*Mail & Guardian* (and its abbreviated form: *M&G*)

*I&J*

*Victoria & Alfred Waterfront* (and its abbreviated form: *V&A Waterfront*)

*O&M (organisation and methods)*

8.1.2 Do not use the ampersand as an abbreviation for ‘and’, except in citations in parentheses.

### 8.2 Apostrophe

8.2.1 Avoid the common error of using an apostrophe with the possessive pronoun ‘its’.

*Its name is Butch – not very original.*

*[NOT: It’s name is Butch – not very original.]*

8.2.2 Do not use apostrophes to create plurals that include names, abbreviations (with or without full stops), numbers and words not usually used as nouns.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMSs</td>
<td>[NOT: SMS’s]</td>
</tr>
<tr>
<td>CVs</td>
<td>[NOT: CV’s]</td>
</tr>
<tr>
<td>BAs</td>
<td>[NOT: BA’s]</td>
</tr>
<tr>
<td>the 70s</td>
<td>[NOT: the 70’s]</td>
</tr>
<tr>
<td>tos and fros</td>
<td>[NOT: to’s and fro’s]</td>
</tr>
<tr>
<td>the three Rs</td>
<td>[NOT: the three R’s]</td>
</tr>
</tbody>
</table>
8.2.3  In more informal contexts, apostrophes are sometimes used to replace the decade in dates – as long as the century is clear.\(^{33}\)

The beat generation of the ’60s

8.2.4  Although apostrophes are generally not used for plurals, there are exceptions, for example, to form the plural of single letters – but not for capital letters or numbers. Common sense and context will often determine the issue.

The word ‘better’ has two t’s.
Mind your p’s and q’s.
Vowels include a’s and i’s. [BUT: He passed matric with straight As.]

8.2.5  Where the apostrophe is used in contractions, place the apostrophe in the position corresponding to the missing letter or letters.

I’m
can’t
mustn’t

8.2.6  Apostrophes imply ‘of’ in the genitive case (similar to possessives and formed like them).

He has six years’ experience.
In a month’s time we will launch the programme.

The apostrophe would be incorrect in the following instance:

She completed her studies three years ago. [NOT: She completed her studies three years’ ago.]

8.2.7  Omit the possessive ‘s’ after singular nouns ending in an ‘s’ or ‘z’ sound when combined with ‘sake’.\(^{34}\)

for goodness’ sake
for appearance’ sake

8.2.8  In the case of proper names ending in ‘s’ or ‘z’ the Language Centre prefers the possessive form without the ‘s’.\(^{35}\)

James’
Jesus’
Sostenes’
Katz’

---


\(^{34}\) A Comprehensive Grammar of the English Language (1985:321).

8.2.9 When a name or term is italicised, leave the possessive ‘s’ unitalicised.

*The Sunday Independent’s* staff
*Dracula’s* exploration of imperialism

8.2.10 Use the possessive ‘s’ after the last of a set of linked nouns sharing possession.

Laurel and Hardy’s comedies
Rice and Lloyd-Weber’s musicals

8.3 Colon

8.3.1 The general rule is to use capitals after colons only if:

- The word following the colon is a proper noun.

The man warned: Chuck Norris takes no prisoners.

- The colon follows a formal salutation or brief instruction.

Please note: The deadline for entries is 21 May 2006.
Warning: Hot surface
May I have your attention: A blue Fiat, CA 12345, seems to have acquired a new owner.

- The material following the colon is a full sentence or a phrase expressing a complete thought.

Shop closed temporarily: We are taking stock from Monday to Wednesday this week.

8.3.2 If the material following the colon does not form a full sentence, do not capitalise.

She packed interesting snacks: blue cheese, crackers, figs and chocolates.

8.3.3 The colon should not precede linking words or phrases in the introduction to a list (see first example below), and should follow linking words only where the colon introduces a main clause (see second example).

Her study focused on two authors, namely Coetzee and Fugard.
[NOT: Her study focused on two authors: namely Coetzee and Fugard.]

She used this example: Of the three central characters in *Wuthering Heights*, the younger Catherine is the most appealing.
8.3.4 Do not use a colon to introduce a statement or a list that completes the sentence formed by the introduction.

Other sites worth visiting include Kirstenbosch Gardens, Cape Nature Reserve and Fish River Canyon.
[NOT: ... include: Kirstenbosch Gardens, Cape Nature Reserve and Fish River Canyon.]

During our holiday we went to Hout Bay, Kommetjie and Cape Town.
[NOT: ... to: Hout Bay, Kommetjie and Cape Town.]

8.3.5 In mathematical equations, do not put spaces before or after the colon.

The ratio between students and learners is 10:5.

8.4 Comma

8.4.1 Do not introduce a comma between subject and verb, or verb and object – even after a long subject – where there would be a natural pause in spoken language.

Those who have the largest incomes and who have amassed the greatest personal savings should be taxed most.
[NOT: Those who have the largest incomes and who have amassed the greatest personal savings, should be taxed most.]

A driver who has drunk too much at a party and then leaves may soon end up in a very sobering situation.
[NOT: A driver who has drunk too much and then leaves, may soon end up in a very sobering situation.]

TIP: Instead of adding a comma before ‘should’ and ‘may’ in the sentences above, consider rephrasing (if the context allows it).

Those who make and save the most should be taxed most.
A driver may soon end up in a sobering situation if he or she has drunk too much before leaving the party.

8.4.2 Commas that isolate additional information work in pairs: Insert a comma before and after additional information (a descriptive clause, phrase or word). If the words between the parenthetical commas were to be removed, the meaning of the sentence should not change.

She lives here in Dalsig, Stellenbosch, after having moved from Northcliff, Johannesburg, to be closer to her family.
There is something about the car, despite its obvious sportiness, that did not appeal to the client.

8.4.3 Use a comma where the same word appears twice in succession only if a comma would facilitate reading or avoid ambiguity.

All the money that he had, had been used for food.
We agreed to move on, on the understanding that we would not be followed.
8.4.4 Even where the structure does not require a comma, use one to eliminate ambiguity.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>However, much as I should like to, I cannot agree. She greeted the official who approached her, and smiled. With the vehicle moving, the passenger jumped out.</td>
</tr>
</tbody>
</table>

8.4.5 If the list comma (also known as the Oxford or serial comma) is used, ensure that it is used consistently throughout the text.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>She asked for pens, pencils, rubbers, and rulers.</td>
</tr>
</tbody>
</table>

8.4.6 The comma is not used in dates, but can be used to indicate specific (official) days and dates.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sunday 1 May</td>
</tr>
<tr>
<td>BUT: Workers’ Day, Sunday 1 May</td>
</tr>
</tbody>
</table>

8.4.7 No comma is necessary between two adjectives the first of which describes the whole unit formed by the second adjective plus the noun.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>a traditional political party</td>
</tr>
<tr>
<td>endangered wild dogs</td>
</tr>
</tbody>
</table>

The same rule applies when the second adjective describes colour.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>They all had long blond hair.</td>
</tr>
<tr>
<td>She bought a lovely red car.</td>
</tr>
</tbody>
</table>

8.5 Dash

8.5.1 Distinguish between the hyphen and the dash. Preferably use the en dash (also called the en rule) with spaces on either side as a dash.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>She studied him carefully – unknown to him – and then pounced. [NOT: She studied him carefully - unknown to him - and then pounced.]</td>
</tr>
</tbody>
</table>

**TIP:** Insert the en dash on a PC by holding down the Ctrl key while pressing the minus symbol – usually in the upper right-hand corner of the keyboard, on the same line as the Num Lock key (Ctrl + -).

8.5.2 Guard against overusing the dash. Its primary function is to set off important or parenthetical information. Often the dash’s function can be performed by other punctuation marks.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The thief, often seen in the area, had escaped with the loot – a whole bagful. OR The thief – often seen in the area – had escaped with a whole bagful of loot. [NOT: The thief – often seen in the area – had escaped with the loot – a whole bagful.]</td>
</tr>
</tbody>
</table>
8.5.3 The en dash without spaces either side (see 8.8.10) is used as a substitute for ‘to’. Note that if the dash is used for this purpose along with the percentage sign, the ‘%’ after the first set of numerals should be omitted.

A range of 3–5% [NOT: A range of 3%-5%]

However, the en dash cannot replace ‘to’ in the phrase ‘from x to y’:

It ranged from 3% to 5%. [NOT: It ranged from 3–5%.

Do not use the en dash after ‘between’ (because the preposition it would replace, would be ‘and’, not ‘to’):

It was somewhere between 3% and 5%. [NOT: It was somewhere between 3–5%.

8.6 Ellipsis

8.6.1 The ellipsis is used to indicate that words have been omitted. Insert a space on both sides of the ellipsis.

He knew that some officials … and members of parliament will be present.

8.6.2 The ellipsis may also be used to indicate that part of a word has been omitted. In such cases, there must be no space between the ellipsis and the last letter of the word.

“I’ll be d…!” he shouted.

8.6.3 When a complete sentence is followed by omitted material, the closing punctuation mark appears at the end of the sentence, as usual, followed by a space and the ellipsis. The example below indicates that at least one full sentence has been omitted.

All that could be heard was the loud roar. … At least one person did not survive the attack.

8.6.4 Sentences ending in a question or exclamation mark retain these punctuation marks, whether they precede or follow the ellipsis:

But how …?
But how had it happened? … they had indeed been able to …!
8.6.5 For the sake of clarity, square brackets can be used to indicate that a writer or editor has inserted an ellipsis into quoted text, i.e. that the ellipsis was not present in the original.

The fact is, Lady Bracknell, [...] my parents seem to have lost me … I don’t actually know who I am [...]. I was … well, I was found.36

The spirit of our American radicalism is destructive and aimless [...]. On the other side, the conservative party [...] is timid, and merely defensive of property. [...] It does not build, nor write, nor cherish the arts, nor foster religion, nor establish schools.37

TIP: To insert an automatically generated ellipsis in MS Word 2007/2010, see 12.6.

8.7 Full stop

No full stop is used in main headings, subheadings or other headings.

8.8 Hyphen

8.8.1 The hyphen makes the relationship between lexical items explicit by joining two or more lexical items in fixed compounds.

anti-inflammatory
son-in-law
three-month-old baby
short-haired dog
one-quarter38

8.8.2 Hyphenation (or the lack thereof) may be used to avoid confusion and ambiguity.39

<table>
<thead>
<tr>
<th>Unhyphenated</th>
<th>Hyphenated</th>
</tr>
</thead>
<tbody>
<tr>
<td>a foreign stamp collector (who is a foreigner)</td>
<td>a foreign-stamp collector (who collects stamps from foreign countries)</td>
</tr>
<tr>
<td>thirty odd people (thirty people who are unusual or strange)</td>
<td>thirty-odd people (approximately thirty people)</td>
</tr>
</tbody>
</table>

8.8.3 Two or more modifiers forming a unit that precedes a noun are hyphenated.

a well-drawn outline
up-to-date records
a long-standing agreement

BUT: Compound modifiers that follow a noun are usually unhyphenated.

The outline is well drawn.
The records are not up to date.
This is an agreement of long standing.

8.8.4 Words with prefixes are often written as one word, except where this may cause confusion or mispronunciation.

re-entry
de-ice
non-effective
vice-chancellor

8.8.5 Prefixes that appear before names and dates should also be hyphenated.

anti-Darwinism
mid-December
pre-1980s
mid-nineteenth century

8.8.6 Hyphenate spelt-out numbers above 20.

twenty-two
eighty-seven
three hundred and forty-three

8.8.7 Use hyphens when writing out fractions.

one-third
five-eighths

8.8.8 The hyphen can be used to indicate omitted units common to a series: the hanging or suspended hyphen.

two-, three- or fourfold
upper- and middle-class citizens
nurse-initiated and -managed antiretroviral therapy (NIMART)

8.8.9 The hyphen can be used in compounds to indicate the meaning ‘and’, ‘or’, ‘until’, ‘between’, or ‘from … to’.

owner-builder (and) [NOT: owner/builder]
mother-daughter relationship (between) [NOT: mother/daughter relationship]
the Stellenbosch-Strand road (from … to) [NOT: the Stellenbosch/Strand road]

On the correct use of the forward slash in cases such as the above, see 8.13.1.

8.8.10 Sometimes the hyphen is difficult to read when it indicates a range. In such instances, use the dash rather than the hyphen for readability.

LU2–LU5 [NOT: LU2-LU5]
8.8.11 The hyphen can be used to break a word at the end of a line (word division).

The briefs for texts to be translated, proofread or edited by the Language Centre almost never require word division. Seeing that word division can be done sensibly only on documents that have been laid out for printing, the Language Centre usually does not indicate word breaks unless explicitly required.

In English, word division is generally determined either by pronunciation or by derivation. Consequently, different dictionaries may indicate different divisions for the same word. For consistency’s sake, the Language Centre advises that language practitioners follow the word divisions of only one dictionary in a particular document.

For technical tips on using hyphenation for word division in MS Word, see 12.7.3.

RULES OF THUMB (if nothing to the contrary is specified in the brief):

- Do not divide single-syllable words.
- Do not divide words at the ends of more than two consecutive lines.
- Do not divide a word leaving only one letter before the dividing hyphen.
- Do not divide a word leaving only one or two letters at the start of the next line after the dividing hyphen.
- Take care that the dividing hyphen does not obscure the meaning of a word; e.g. ‘re-cover’ as a divided word could be either ‘recover’ or ‘re-cover’ when fitted into one line.
- Pronunciation may result in different divisions for the same word in print, depending on its meaning in context; e.g. ‘divide’ as a noun may have no divisions, but as a verb it may be divided ‘di·vide’.

8.9 Parentheses

8.9.1 Use parentheses instead of the solidus when adding one or more letters to a word to indicate an alternative form.

actor(s) [NOT: actor/s]

8.9.2 A complete sentence in parentheses begins with a capital letter and ends in a full stop only if it does not appear within another sentence – even when it ends the enclosing sentence.

Squeals of laughter echoed through the streets. (It was holiday time.)
Squeals of laughter echoed through the streets (it was holiday time).
Squeals of laughter (it was holiday time) echoed through the streets.

8.9.3 When using brackets where only part of a sentence appears in parentheses, insert the full stop after the closing bracket.

Squeals of laughter echoed through the streets (as usual during holiday time).

8.9.4 Use square brackets for parentheses that appear within round brackets.

The results compare favourably with similar or existing technology. (This measurement is done [as far as possible, we have to concede] according to local and international standards.)

8.9.5 Square brackets are used to indicate additions and changes to quotations in scientific writing.

8.10 Question mark

8.10.1 Matter following a question mark begins with a capital letter.

Would you like chocolate? Cake? Cream?

... except when a question is contained within another sentence:

The concern *Is it possible?* is likely to cause many sleepless nights.

8.10.2 The first words of questions contained within another sentence may or may not be capitalised themselves, depending on the impact intended and on the formality of the context. The question mark is placed at whatever point the question ends in a sentence (example 3 below).

This prompts the question, Can this be allowed to continue?
She wondered, *why not?*
The concern *Is it possible?* is likely to cause many sleepless nights.

8.10.3 Avoid the double question mark (??) and the interrobang (!?), which is used to add incredulity to a question.

8.11 Quotation mark

8.11.1 In general, double quotation marks should be reserved for direct speech, for quotations from other sources and for indicating a title as set out in 1.3.5.2. Single quotation marks are used when words carry a particular significance, when words are referred to as words, when words are meant ironically, when words are used out of context and when words may be unfamiliar to the reader.

The question is whether the ‘wonderful’ plan worked out. (irony)
‘Affect’ and ‘effect’ are often confused. (words referred to as words)
The expression ‘generic black’ is employed as an umbrella term in this document. Generic black students must form a certain percentage of the student profile. (words that are defined for the purposes of a particular text – quotation marks are used at the first occurrence, but elsewhere the expression is used without quotation marks)
8.11.2 The Language Centre prefers that single quotation marks be used within double ones when a quotation appears within a quotation.

“I suggest,” she said, “that you embrace the theory of ‘no pain, no gain’ when working on that six-pack.”

8.11.3 Use single, not double, quotation marks in newspaper headlines and headings in newsletters.

Stormers told to ‘win back the supporters’

8.11.4 Put the terminal punctuation inside the quotation marks when the quoted material forms a complete sentence or question. This is in line with general British English usage. Do not duplicate the terminal punctuation by putting another mark outside the quotation mark.

She remarked, “I suggest that you focus on your immediate environment.” [NOT: She remarked, “I suggest that you focus on your immediate environment.”.]
He asked, “Would that be all right?” [NOT: He asked, “Would that be all right?”.]

8.11.5 When the quoted material does not form a complete sentence or utterance, put the terminal punctuation outside the quotation marks.

She remarked that I should focus on my “immediate environment”.

**TIP:** Note the difference between straight quotation marks (‘…’ or "...") and smart quotation marks (‘…” or "…”) – the latter are in the shape of the numerals 6 and 9. Make sure that one type of quotation mark is used consistently throughout a single document. See 12.4.3 about setting your computer to produce one type or the other automatically.

**NOTE:** The symbol for measurement in inches is " (the double prime), which may also be indicated by straight (not ‘smart’) double quotation marks. The symbols for arcminutes and arcseconds (subdivisions of the measurement for angles, the degree) are respectively ’ and " (the single and double prime), which may also be indicated by straight (not ‘smart’) single and double quotation marks: 40° 11' 15".
### 8.12 Semicolon

The semicolon is used to structure components that belong together, thus helping the reader to see the relationship between components clearly and at first glance.

**8.12.1** In a sentence that has already been subdivided by commas, use a semicolon instead of a comma to indicate a stronger division.

They were allowed to proceed, even without the required documents, to the next destination; but, having encountered some resistance, they changed their minds.

**8.12.2** When an unbulleted list consists of long items, semicolons can serve to keep the sentence structure clear.

Semicolons are very helpful: they provide strong breaks; they don’t break up the structure of a sentence; and they are useful stepping stones.

**8.12.3** In a list where any of the items themselves contain commas, use a semicolon to clarify the internal hierarchy of the items.

Those present included Trafalgar High, Cape Town; Paul Roos Gymnasium, Stellenbosch; and Windsor Senior Secondary, Port Elizabeth.

### 8.13 Solidus/Slash

**8.13.1** The solidus is used mainly to separate alternatives (not as a replacement for ‘and’ or ‘or’) and is usually neither preceded nor followed by a space.

solidus/slash/forward slash/slant/oblique

and/or

**8.13.2** Using a solidus can cause ambiguity.

pink daisies/roses (may refer to pink daisies or pink roses, OR to pink daisies or roses of any colour)
executive members/consultants (may refer to consultants who are also executives, OR to consultants who are not)

Sometimes spaces are inserted on both sides of the solidus in an effort to clarify the meaning:

pink daisies / roses
executive members / consultants

Often ambiguity as well as inserting spaces before and after the solidus can be avoided simply by changing the sequence of the items.

roses/pink daisies
consultants/executive members
8.13.3 The solidus forms part of certain abbreviations.

- a/c (account)
- c/o (care of)
- 24/7 (twenty-four hours a day, seven days a week)

The solidus should not be used instead of a full stop in abbreviations in general.

- PO Box [NOT: p/o box]
- BA degree [NOT: B/A degree.]
- HO building [NOT: H/O building]

8.13.4 Use a solidus to indicate a financial year that extends across calendar years.

- 2001/2002 year of assessment
- OR
- 2012/13 year of assessment

8.13.5 Do not use a solidus to indicate the meaning ‘and’, ‘until’, ‘between’ or ‘from … to’ as set out in 8.8.9 (except in cases as set out in 8.13.4).
9. Numbers

9.1 General

9.1.1 When used in text, write out in full the numbers from one to nine and numbers used figuratively. (In Afrikaans the numbers from one to ten are written out in full.) See also Section 2, ‘Addresses and telephone numbers’, for other uses.

We have two children. [NOT: We have 2 children.]
I’ve told you a thousand times. [NOT: I’ve told you a 1 000 times.]

9.1.2 When two sets of figures are mixed, sometimes it is clearer to use words for one and figures for the other.

Forty 9-page documents

9.1.3 For purposes of consistency, numbers below and above nine that appear in the same sentence should either all be written out or appear as numerals. In simple cases, the format used is usually determined by which form appears first. Numbers that appear in the rest of the sentence or paragraph may also influence the format chosen. Try to keep the text as reader-friendly as possible.

<table>
<thead>
<tr>
<th>Determined by first form</th>
<th>Determined by context</th>
</tr>
</thead>
<tbody>
<tr>
<td>There were eight students in one class and eleven in the other.</td>
<td>Acocks’s original 7 biomes have been extended to 9 continental biomes and 2 on the Prince Edward Islands, and his 79 veld types to 435.</td>
</tr>
<tr>
<td>Although 25 students had initially been enrolled, only 7 completed the course.</td>
<td></td>
</tr>
</tbody>
</table>

9.1.4 Do not begin a sentence with a numeral. Instead, write the number in words or rephrase the sentence.

Eleven learners were excluded. OR The number of exclusions was 11. [NOT: 11 learners were excluded.]
Eighty per cent of households have pets. [NOT: 80% of households have pets.]

Rephrase a sentence to avoid spelling out cumbersome numbers that are at the beginning.

A total of 20 300 people attended the concert. [NOT: Twenty-thousand three-hundred people attended the concert.]
9.1.5 A number that has been written out must be followed by the words ‘per cent’, not the symbol ‘%’.

Exclusions have fallen by five per cent.  
[NOT: Exclusions have fallen by five %.]  
[NOT: Exclusions have fallen by 5 per cent.]

9.1.6 Do not insert a space between a numeral and the percentage symbol.

80%

9.1.7 When ‘to’ is being used as part of a ratio, it is usually best to write it out.

They decided by 30 votes to 12 to put the matter to the general assembly, which voted 27 to 19.  
[NOT: They decided by 30:12 votes to put the matter to the general assembly, which voted 27:19.]

9.1.8 Write out ‘million’ and ‘billion’ unless they appear in a table, and use a hard space to separate the figure from the word (see 12.5 on how to insert a hard space).

R8 million  
23 billion

NOTE: In British and South African English ‘billion’ used to mean a million million (10^{12}). This differed from the American usage of ‘billion’, namely to mean a thousand million (10^9). However, this usage of ‘billion’ in British and SA English (together with ‘milliard’ in the sense of 10^9) is dated now, and the American meaning has become the norm.\(^{41}\)

The word ‘milliard’ has become almost obsolete. Consequently, both Afrikaans terms ‘biljoen’ and ‘miljard’ are translated as ‘billion’.\(^{42}\)

9.1.9 Numbers and monetary values are indicated as follows (with hard spaces and no commas as thousands separators):

<table>
<thead>
<tr>
<th>Number</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 359</td>
<td>[NOT: 1,359]</td>
<td></td>
</tr>
<tr>
<td>125 359</td>
<td>[NOT: 125,359]</td>
<td></td>
</tr>
<tr>
<td>R7,50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R1 777,99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R147 777,99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^{41}\) Concise Oxford English Dictionary (2008: ‘billion’).  
In South Africa the decimal comma is used. In a text where the decimal full stop is used instead of the comma, it is good practice to alert the client to the fact that the decimal comma is preferable. Do not change this summarily.

In most financial and accounting texts, the comma is used as thousands separator (e.g. R1,500,000.00). Follow the client’s preference (either explicitly stated or deduced from the source text) when translating and do not change this when editing, but do insert a comment about the matter. Do not use the comma as a thousands separator in any other type of text.

### 9.2 Currency

There is no space between a currency symbol and the figure.

<table>
<thead>
<tr>
<th>Currency</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>R8,50</td>
<td></td>
</tr>
<tr>
<td>US$45</td>
<td></td>
</tr>
</tbody>
</table>

‘US’ is added only if it is necessary to distinguish the US dollar from another country’s monetary unit, such as the Zimbabwean dollar (Z$3 000).

### 9.3 Punctuation

#### 9.3.1 Use a hard space as thousands separator in general text (see 12.5 on inserting a hard space).

The school has 1 500 learners.

#### 9.3.2 Use common fractions or percentages rather than decimals where possible.

Three-quarters of the staff are women.

Women make up 75% of the staff.

#### 9.3.3 Fractions of less than one are usually written out, with hyphens between the word elements, while fractions larger than one are usually written as numerals.

A tenth of children are bullied at school. [NOT: One-tenth of children …]

Her new job meant a salary increase of 1,5 times her original salary.

#### 9.3.4 References to time

See 1.3.1.
10. Scientific writing

- At SU a thesis is usually a document that is submitted to comply with the requirements set for a master’s degree. If this document comprises less than 50% of a master’s degree study, it is called a research assignment. A dissertation is submitted for a doctorate.

- In this section, the term ‘thesis’ is used to include dissertations, academic articles as well as research assignments.

The Language Centre offers the following options to clients who wish to have their theses edited. We differentiate between –

1. a comprehensive edit that includes the editing of the text as well as the reference list (the editor also checks the in-text references against the reference list and vice versa);

2. a less comprehensive option, where the editor edits the text only; and

3. an option where only the reference list is edited and the cross-references are checked.

Click here for a document that sets out the three options in more detail. The Language Centre does not offer a service for technical editing. Therefore the editor is not expected to work on the layout.

When performing a comprehensive edit, however, we do insert page numbers according to the set requirements. See 10.3.1 for tips on inserting page numbers.

10.1 In general

Editing theses, dissertations and other academic writing should be approached with caution. From an ethical point of view the editor may not over-edit or rewrite substantially, since the client is usually a student who will be assessed on the basis of this work to obtain an academic qualification. It is most important to deal with thesis editing responsibly.

10.1.1 How much is too much?

Editing should never change the content or structure of a thesis. The scope of the editor’s changes should not go beyond improving grammar, spelling and punctuation, ensuring idiomatic language usage and the correct choice of words, and applying text mechanisms to improve cohesion. If a sentence has to be rewritten, retain the client’s

http://www0.sun.ac.za/taalsentrum/assets/files/TaaldiensDokumente/Thesis%20editing%20info%202014_colour_links.pdf
own wording as far as possible. If it is necessary to comment on aspects regarding the content, such as ambiguous facts or problematic lines of argumentation, inserting comments is the appropriate way of indicating such deficiencies. See 12.3 for guidance on inserting comments.

10.1.2 Guidelines

It is the client’s responsibility to supply the Language Centre with applicable guidelines in general and guidelines on the required referencing method, if those differ from the University’s general guidelines on referencing. The editor must ensure that the guidelines have been followed consistently.

The research-focused nature of a thesis requires that it contains a reference list. The system according to which sources are cited in the text and in the reference list is crucial, and could vary between institutions and even between academic departments of one institution. More on this in 10.3.6.

10.2 The constituent parts of a thesis

10.2.1 Preliminaries

The preliminary pages of a thesis should occur in the following order, unless the client has requested a different order:

- Title page, containing the correct wording (as set out in Part 1 of the University Calendar\(^{44}\))
- Declaration of the originality of the thesis, with space for the date
- Abstract in English
- Abstract in Afrikaans (Opsomming)
- Acknowledgements
- Dedication (if the client wishes to dedicate the study to someone)
- Table of contents

\[\text{NOTE: If the thesis is written in Afrikaans, the Afrikaans abstract should precede the English abstract.}\]

\(^{44}\) SU Calendar 2014, Part 1 (2014:155, par. 5.7).
A new translation of the Bible in Xhosa: Perspectives on theory and practice

Tsidi Mahlangu

Thesis presented in partial fulfilment of the requirements for the degree of Master of Arts in the Faculty of Arts and Social Sciences at Stellenbosch University.

Supervisor: Prof HL Visagie

December 2014
10.2.1.1 The title page

The requirements according to Part 1 of the University Calendar are as follows:

The title of the thesis should appear in the top third of the first page, and directly below this the author’s full names and surname.

The following wording must be inserted below the author’s name:

Research assignment/Thesis presented in partial fulfilment of the requirements for the degree of Master of … (e.g. Arts) in the Faculty of (name of faculty, e.g. Arts and Social Sciences) at Stellenbosch University.

Prescribed wording for Afrikaans theses:

Navorsingswerkstuk/Tesis ingelewer ter gedeeltelike voldoening aan die vereistes vir die graad van Magister in … (e.g. ‘die Wysbegeerte’) in die Fakulteit (name of faculty, e.g. ‘Fakulteit Lettere en Sosiale Wetenskappe’) aan die Universiteit Stellenbosch.

‘Partial’ should be used in this wording only if it is not a 100% thesis, or if it is a 100% thesis but an oral examination is also required to complete the programme.

The name(s) of the supervisor(s) and the year and month in which the degree will be conferred (March or December) should appear at the bottom of the page.

See page 62 for an example of a title page.

NOTE: For a doctorate, replace ‘thesis’ with ‘dissertation’. ‘Supervisor’ applies to both master’s and doctoral studies (SU no longer uses the term ‘promoter’).

45

10.2.1.2 The declaration

The declaration appears in the upper half of the second page and should be worded as follows:

Declaration

By submitting this thesis electronically, I declare that the entirety of the work contained therein is my own, original work, that I am the sole author thereof (save to the extent explicitly otherwise stated), that reproduction and publication thereof by Stellenbosch University will not infringe any third party rights and that I have not previously in its entirety or in part submitted it for obtaining any qualification.

Date:

45 According to an SU Council decision.
Set wording for Afrikaans theses:

**Verklaring**

Deur hierdie tesis elektronies in te lewer, verklaar ek dat die geheel van die werk hierin vervat, my eie, oorspronklike werk is, dat ek die alleenouteur daarvan is (behalwe in die mate uitdruklik anders aangedui), dat reproduksie en publikasie daarvan deur die Universiteit Stellenbosch nie derdepartyregte sal skend nie en dat ek dit nie vantevore, in die geheel of gedeeltelik, ter verkryging van enige kwalifikasie aangebied het nie.

Datum:

10.2.1.3 The copyright note on the second page

The note below (reflecting the year of electronic submission) should appear in the lower half of the second page:

© 2014 Stellenbosch University
All rights reserved

Equivalent wording for Afrikaans theses:

Kopiereg © 2014 Universiteit Stellenbosch
Alle regte voorbehou

10.2.1.4 The table of contents

An example of a table of contents:

<table>
<thead>
<tr>
<th>Table of contents</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Declaration</td>
<td>ii</td>
</tr>
<tr>
<td>Abstract</td>
<td>iii</td>
</tr>
<tr>
<td>Opsomming</td>
<td>iv</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>v</td>
</tr>
<tr>
<td>List of tables</td>
<td>viii</td>
</tr>
<tr>
<td>List of figures</td>
<td>ix</td>
</tr>
<tr>
<td>List of abbreviations</td>
<td>x</td>
</tr>
</tbody>
</table>

**CHAPTER 1 ORIENTATION**

1.1 Introduction       1
1.2 Problem statement  1
1.3 Research aims      2
1.4 Literature study   2
The table of contents should not appear as an item in the table of contents itself. All items in the table of contents should be assigned page numbers, and all items except the preliminaries and the reference list should be numbered.

Numbering should preferably not exceed the fourth level:

```
1
1.1
1.1.1
1.1.1.1
```

Any further subsections should be indicated with Roman numerals (i, ii, iii, etc.) or letters of the alphabet (a, b, c, etc.). Such headings should preferably not be included in the table of contents.

**NOTE:** If you make changes to the headings in the table of contents (including the lists of figures and tables), it is crucial to transfer those changes to the headings in the text itself (e.g. in paragraph headings and figure/table titles), and vice versa.

Automatically generated text:
If the table of contents or lists of figures and tables are generated automatically, *do not make changes to them.* Make sure, however, that the necessary changes have been made to the headings in the text. The client will have to refresh the automatically generated table of contents and other lists after having worked through the proposed changes in the text and accepting or rejecting them.

Also take care, when editing headings or titles in the text, not to delete field codes that enable the automatic generation of lists.

If the thesis contains *figures and tables,* these elements must be listed separately. The resulting lists must appear as items in the table of contents (see the example at the beginning of 10.2.1.4) and the lists themselves must be inserted after the table of contents. For more on editing figures and tables, see 10.3.5.

Finally, a list of abbreviations or a list explaining acronyms could follow the table of contents. If such a list is included, it must appear in the table of contents. See the example at the beginning of 10.2.1.4.

10.2.2 The reference list

The reference list follows directly after the last chapter, i.e. before the appendices, and should not be numbered as a section or chapter. For more on editing reference lists, see 10.3.6.

10.2.3 Appendices

Appendices are usually numbered A, B, C, etc. They follow the reference list and comprise the last pages of the thesis. Appendices are also listed in the table of contents. Often they consist of questionnaires and other information in a format that was used in earlier stages of the research. For this reason, appendices should usually not be edited – unless specifically requested.
10.3 Important detail

10.3.1 Page numbers

The title page of a thesis is not numbered. The declaration page should be ‘ii’, and the subsequent pages up to (but not including) the first page of Chapter 1 should be numbered with Roman numerals. The first page of Chapter 1 should be numbered ‘1’ (Arabic numeral). For tips on numbering the first few pages with Roman numerals and the rest with Arabic numerals, see 12.8.2.

If a thesis is to be edited comprehensively, the editor is expected to check and correct page numbers or insert them, if necessary. The less comprehensive option still requires that the editor comment on the page numbers if they are incorrect.

10.3.2 Font type, font size and line spacing

The thesis should be typed in an easily legible font type, for example Arial, Times New Roman or Verdana. The font size may vary between 10 and 12. The writing and other contents on a page should be framed by white space of 2 cm around the edges. Line spacing may be one, one and a half or double. We would recommend line spacing of one and a half.

10.3.3 Punctuation

- Ensure that either straight quotation marks or smart quotation marks are used consistently (see the tip at 12.4.3). Electronic editing often requires that a page or two be printed to check for consistency in this regard. SU has no preference regarding the style of quotation marks, as long as one style is applied consistently throughout a single document.
- Specific rules apply to the punctuation of quotations and references. Be sure to study the guidelines that the client has provided.
- The Language Centre now retains the hyphen when a range of page numbers is indicated (particularly in reference lists) rather than replacing it with the en dash. Consistency remains the deciding factor.

<table>
<thead>
<tr>
<th>English</th>
<th>Afrikaans</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is customary in English to regard the names of chapters, figures, etc. as proper nouns and therefore to capitalise the initial letter in cross-references. In Afrikaans, the opposite applies.</td>
<td>Die sketse in hoofstuk 2 toon dat … soos uitgebeeld in figuur 2.5.</td>
</tr>
</tbody>
</table>

10.3.4 Quotations

- Do not make changes to direct quotations. If a quotation seems to contain an error, insert a comment to draw the client’s attention to the possible error. Suggest a correction or, if there is no error of transcription, that the client insert ‘sic’ to indicate an error in the source.
• Usually quotations consisting of more than 40 words should be blocked. Remember that blocked quotations do not have quotation marks.
• See 8.11 for guidelines about quotation marks.

10.3.5 Figures and tables
• All figures and tables should have suitable titles, which should be listed in the table of contents under a separate section for figures and tables.
• The table or figure should be placed as close as possible after the paragraph in which it is referred to for the first time.
• The table or figure should be numbered appropriately. In Chapter 2, for example, the first figure will be numbered as Figure 2.1 and the second as Figure 2.2. The first figure in Chapter 3 will be Figure 3.1, etc. The same applies to the numbering of tables.
• If a figure or table has been taken from another source, an accurate reference to the source should appear below the figure or table.
• It is customary to place the title of a figure below the figure, while the title of a table is placed above the table.

Often it is impossible to edit the text accompanying figures or tables. The images may have been scanned in, or maybe the editor simply does not have access to the original figures or tables. If you wish to make or suggest changes, insert a comment and set out clearly what changes are to be made.

10.3.6 References

10.3.6.1 Referencing methods and guidelines

Ensure that you know which guidelines the client had to follow regarding references.

The Harvard referencing system distinguishes between a reference list and a bibliography. A reference list contains only the sources that are referred to in the text, whereas a bibliography contains all the sources that the author has consulted, even if those sources are not mentioned in the text. The details of each in-text reference should appear in the reference list or bibliography. The Harvard method is followed in most theses that the Language Centre edits, and usually a reference list is required.

Electronic guidelines on the Harvard, APA and Vancouver systems are available from the Language Centre. In addition, the hard-copy publication Make Sense of Referencing (2010) by Tobie van Dyk and Marisca Coetzee is a user-friendly guide on referencing and is for sale at the Language Centre. Scientific Writing Skills (2007) by Amanda Lourens and Laetitia Bedeker is also a handy source on scientific writing and referencing.

Have a look at the back of this Style Guide for a basic example of a reference list according to the Harvard system. (Note that the in-text references in the Style Guide do not follow the Harvard system.)

See 11.4 for dealing with legislation in a reference list.

46 Make Sense of Referencing (2010:14).
10.3.6.2 Working method

A comprehensive edit requires that all references to sources be checked thoroughly. This entails editing the complete reference list according to the guidelines that have been provided. If the same error occurs repeatedly, a comment could be inserted to alert the client to attend to other instances of that error. However, do not edit only the first five entries and then instruct the client in a comment to do the rest. Clients generally make many referencing errors and some departments do not provide sufficient guidelines on referencing. Therefore, the editor should be knowledgeable enough to make suggestions. Also check with the Language Centre for guidelines and suggestions.

We recommend that the editor print the reference list or save it in a separate electronic document, and keep it at hand while editing. In this way the in-text references and sources can be checked as you progress through the document. Whenever the text refers to a source it must be cross-checked against the reference list to make sure that the particular source is indeed listed and that the details of the in-text reference correspond precisely with the entry in the reference list. If a source does not appear in the reference list, insert a comment for the client to add the necessary particulars. This applies both ways – if the reference list mentions a source that is referred to nowhere in the text, indicate that in a comment.

The MS Word find feature (see 12.2) is a great help for checking references.

---

**TIP:** If reference list entries contain internet references, the web address may be broken off as follows: *in front OR after [=] and [&], and after [,], [!], [/], [-], [~], [\], [?] and [%].*

---

**NOTE:** The information in the reference list should be in the same language as the rest of the document. If the text referred to is in German, but the thesis is in English, the place of publication should be Munich, for example, not München.

10.4 In conclusion

A thesis editor should never lose sight of the academic purpose of a thesis. Strive to deliver a thesis that is still the client’s own work – albeit a more polished version.

Turn to the next page for the Language Centre’s “After-editing checklist”.
After-editing checklist

Use the checklist below to make sure that you have not missed something in the editing process.

- In general
  - Scroll through the edited document in Final view with the spell checker switched ON.
  - Read through all inserted comments.

  Check for:
  - Accuracy of title page
  - Accuracy of set wording on preliminary pages
  - Correct page numbering
  - Double spaces (use MS Word’s find feature)
  - Consistent spelling of subject-specific terms, specific spelling of certain words
  - Use of past tense to report on study
  - Capitalisation of Chapter 1, Chapter 2, etc. when referred to in the text
  - Correct numbering of tables and figures
  - Correct placement of titles of tables and figures
  - Meaningful hierarchy of headings in text
  - Consistency of specific style of in-text references, e.g. (White, 2011:34), (White 2011:34) or (White 2011: 34)

- Reference list
  - The heading should not be numbered.

  Check for:
  - Alphabetical order of entries
  - Correct and consistent punctuation
  - Consistency concerning capitalisation
  - Dates of access for all web references, where applicable
11. Legislation and case law

11.1 Useful resources


11.1.2 The link to Juta’s SA law reports from the University Library’s home page, at http://ipproducts.jutalaw.co.za.ez.sun.ac.za/nxt/gateway.dll?f=templates&fn=default.html&vid=Publish:10.1048/Enu.


11.2 Acts: titles and numbers

11.2.1 The title and number of an act may be written in any of these three ways:

<table>
<thead>
<tr>
<th>Title and Number</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>Labour Relations Act, No. 66 of 1995</td>
</tr>
<tr>
<td>OR</td>
<td>Labour Relations Act (No. 66 of 1995)</td>
</tr>
</tbody>
</table>

11.2.2 Since 1997/1998, all South African legislation is published in English and translated into one of the other official languages. The English text, therefore, is considered the primary text for all legislation after that date.

---

47 This is how acts are referred to in Juta’s law reports (see 11.1.2 above), as well as how the journals Acta Juridica and De Rebus handle this, and what is prescribed by Stellenbosch Law Review (4.5.1 in their Editorial Policy and Style Guide; see 11.1.1 above) and UCT’s Research, Writing, Style and Referencing Guide (see 11.1.3 above).
**TIP**: To check the correct official title of an act, search a reliable source (see 11.1.2 and 11.1.5 above) by means of the act number or the year of publication.

11.2.3 Some acts come to be known by their abbreviated English titles, even in other languages. In such cases, provide the full official title along with the abbreviation the first time the act is referred to.

<table>
<thead>
<tr>
<th>Title Abbreviation</th>
<th>Official Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esta</td>
<td>Extension of Security of Tenure Act</td>
</tr>
<tr>
<td>RICA</td>
<td>Regulation of Interception of Communications and Provision of Communication-related Information Act</td>
</tr>
</tbody>
</table>

11.2.4 Take note of the use of capital letters and lower case regarding legislation.

- The constitution of another country
  - BUT: the South African Constitution
  - (See also 11.4.2 on the SA Constitution.)

### 11.3 Legislation: subsections

11.3.1 Use ‘article’ and ‘section’ with care. The Afrikaans word ‘artikel’ is translated as ‘section’ in this context. Also note that the lower-case form is standard.

11.3.2 There are no spaces between the different elements of a section.48

- section 14(11)
- section 14B
- section 1(a)
- section 14(1)(b)(ii)
- section 14(1)(bA)

11.3.3 When subparagraphs are indicated by means of letters, such letters (but not the brackets around them) are italicised. Numbers indicating subparagraphs, however, are not italicised.

- See subparagraph (ii) of paragraph (c).

Watch out for lower-case letters that function as roman numerals instead of letters:

- Ignore subparagraphs (xvi) and (x), and subsection (3).

---

48 Standard Citation Conventions on the web page of UCT’s Law Library as well as UCT’s Research, Writing, Style and Referencing Guide (see 11.1.3 above), *De Rebus* and *Acta Juridica*. 
11.4 Acts in a list of references

11.4.1 In a list of references, acts are not arranged alphabetically according to the first word of the official act name, but under ‘R’ for ‘Republic of South Africa’ or under ‘S’ for ‘South Africa’.49 Choose one form (‘R’ or ‘S’) and use it consistently, also ensuring that the in-text references and the entry in the reference list match precisely (e.g. ‘RSA’ does not refer to an entry under ‘Republic of South Africa’ but to an entry under ‘RSA’).

OR

11.4.2 Seeing that the 1996 Constitution was approved by the Constitutional Committee, it is not an act of Parliament. Thus it is not numbered like other acts of Parliament, and it may not be referred to as ‘Act 108 of 1996’.50

In-text reference (choose one form and use it consistently):

Constitution of the Republic of South Africa (RSA 1996)
OR
Constitution of the Republic of South Africa (SA 1996)

In the list of references (choose one form and use it consistently):

OR

11.5 Case law51

11.5.1 Contesting parties’ names appear in italics, with spaces between the various elements of the case number.52

*Avex Air (Pty) Ltd v Borough of Vryheid 1973 (1) SA 617 (A)*

---

49 Constructing a Good Dissertation (1996); Citation and Bibliographic Reference Guide (2004:27).
50 Stellenbosch Law Review, 4.5.2 in their Editorial Policy and Style Guide (see 11.1.1 above).
51 Stellenbosch Law Review, 4.4.1 and 4.4.2 in their Editorial Policy and Style Guide (see 11.1.1 above) and Juta’s law reports (see 11.1.2 above).
52 Juta’s law reports (see 11.1.2 above), Acta Juridica, De Rebus, Stellenbosch Law Review (see 11.1.1 above) and UCT’s Research, Writing, Style and Referencing Guide (see 11.1.3 above).
11.5.2 The constituent elements of a citation are:

Avex Air (Pty) Ltd v Borough of Vryheid = contesting parties  
1973 (1) = the year and the volume of the SA law reports  
SA = a South African case  
617 = the page where the case is mentioned for the first time  
A = Appeal Court

**NOTE:** Under the new constitutional dispensation, the former Appellate Division has been replaced by the Supreme Court of Appeal, which is abbreviated 'SCA' (Afr. HHA).

*Only the name of the case* is cited in the main text. Particulars such as year, volume, page number and court should be set out in an accompanying footnote. Where a footnote refers to a case that is also referred to in the preceding footnote, only the relevant page or paragraph of the judgment is cited in the following footnote.

Where a text refers to the same case regularly, the full case reference has to appear only in the first citation. Thereafter, only the relevant page number or paragraph of the judgment is cited.

It is permissible to use an abbreviated version of the case name in the main text (e.g. ‘the Tao Ying case’), but not in footnotes.53

11.5.3 Leave the names of the parties untranslated.

*Pretorius Bemarkers v Kaapstad Munisipaliteit*  
[NOT: Pretorius Marketers v Cape Town Municipality]

11.5.4 When quotations from law reports are translated (e.g. for use in class notes), the Language Centre suggests adding a statement to that effect in brackets at the end of the translated quotation.

---

53 Stellenbosch Law Review, 4.4.2 in their *Editorial Policy and Style Guide.*
12. Technical tips

The tips in this section apply specifically to MS Word 2007/10. If you are using another version of MS Word and are unsure about how to do something, feel free to contact the Language Centre directly.

12.1 The track changes function

NOTE: The Language Centre requires that language practitioners use the track changes function for all editing work (unless we specifically ask that it not be used). For translations this function must be deactivated, of course.

12.1.1 Switching Track Changes on

Click on the Review tab on the Office ribbon at the top of the MS Word window, and then on Track Changes.

OR

Hold in the Shift key and the Ctrl key and press E on the keyboard.

To check whether Track Changes is activated in a specific document, type something in the document. If it displays as underlined and in another colour, the function is switched on.

12.1.2 Switching Track Changes off

Click on the Review tab on the Office ribbon at the top of the MS Word window, then on Track Changes. If the function is activated, the button will be highlighted. To switch it off, click on Track Changes once again.

OR

Hold in the Shift key and the Ctrl key and press E on the keyboard.

12.1.3 Editing with Track Changes switched on

When Track Changes is activated, all inserted text will display as underlined text in a different colour. Depending on the MS Word settings on the particular computer, deleted text will either be indicated as such in the margin or be displayed in a different colour and with a line striking it through.
To toggle between the way tracked changes are displayed (in-line or in balloons in the margin):

Go to the **Review** tab on the Office ribbon. In the **Tracking** group, click on **Show Markup**. On the drop-down menu, choose **Balloons** and tick the option of your choice.

It is best to keep the document in **Print Layout** view, where the tracked changes are less obtrusive. To display a document in **Print Layout** view:

Click on the **View** tab on the Office ribbon at the top of the MS Word window, then on **Print Layout** on the far left.

OR

Click on **Print Layout** in the group of icons on the far right on the status bar, at the bottom of the MS Word window.

To reverse a change in order to get back the original text:

Right-click on the change, then click on **Reject Change**.

OR

If MS Word is set up to indicate deleted text as such in the right-hand margin: Right-click on the **Deleted** box in the margin on the right and reject the change.

After the editing process has been completed, hide the tracked changes temporarily in order to read through the document without being distracted by the various coloured insertions and deletions. Visible tracked changes often make it difficult to spot, for instance, extra spaces between words or punctuation marks. To hide tracked changes:

Click on the **Review** tab on the Office ribbon at the top of the MS Word window. Open the drop-down list in the **Tracking** group and click on **Final**. (If tracked changes are visible in the document, **Final Showing Markup** will be highlighted in the drop-down list.)

**12.2 The find feature**

The find feature is on the **Home** tab, on the far right. **Find** is especially handy to check the following:

- Double spaces – type two spaces in the **Find what** bar to find all double spaces in a document and remove those that are incorrect.

- Words, abbreviations or character combinations that frequently occur wrongly or are used inconsistently in a text – ensure that not one instance has slipped through. For example, in Afrikaans to English translations, ‘en’, ‘die’, ‘met’ and ‘van’ sometimes remain untranslated as well as undetected. A spell checker will not flag such oversights, because they seem to be correct English words.

- References – in a list of references as well as the corresponding in-text references, use **Find** to ensure consistency in referencing style.
12.3 Comments

Insert any comments for the client’s or the Language Centre’s attention at the relevant place in the text by means of MS Word’s comments function.

12.3.1 Inserting a comment:

Highlight the piece of text that the comment refers to.

Click on the Review tab on the Office ribbon at the top of the MS Word window and then once on New Comment. A small block will appear in the right-hand or left-hand margin (depending on the MS Word settings on the particular computer): type in your comment.

OR

Right-click on the particular word or sentence and select New Comment at the bottom of the drop-down list.

Please address comments specifically to either the Language Centre or the author. Begin the comment with ‘Language Centre: ...’ or ‘Author: ...’. Try to formulate each comment in such a way that it can function as a self-contained, precise remark, leaving no uncertainty about what should be done to improve or rectify the matter. When formulating comments specifically for the client’s attention in the language combination English<>Afrikaans, keep in mind that not all clients understand Afrikaans.

12.3.2 Deleting an existing comment:

Right-click on the comment block and then on Delete Comment.

12.4 Formatting quotation marks

12.4.1 To ensure that the single quotation mark used in the Afrikaans determiner ‘’n’ is displayed correctly:

1. Hold down the Alt key.

2. Make sure that Num Lock is on and type the code 0146 on the numerical keys on the right-hand side of the keyboard.

   NOTE for some laptops: Press the Fn key in combination with the Num Lock key in order to activate Num Lock. Use the letter keys that also function as numerical keys to type in the code, for instance m = 0; j = 1; u = 4; o = 6.

3. Release Alt and type ‘n’.

For an alternative way of producing letters with diacritical marks and other symbols, hold down the Alt key and type the correct code on the numerical keypad:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>é</td>
<td>Alt + 130</td>
</tr>
<tr>
<td>à</td>
<td>Alt + 133</td>
</tr>
<tr>
<td>° (degree symbol)</td>
<td>Alt + 0176</td>
</tr>
<tr>
<td>€ (Euro sign)</td>
<td>Alt + 0128</td>
</tr>
</tbody>
</table>

To view an explanation of symbols or special characters and their codes in MS Word: Click on the Insert tab on the office ribbon at the top of the MS Word window, and then on Symbol > More symbols on the far right.
12.4.2 There is a shortcut to ensure that the single quotation mark used in the Afrikaans word ‘’n’ is displayed correctly:

1. Hold in the Ctrl key.
2. Press the key for the single or double quotation mark (usually next to Enter on the keyboard) twice.
4. Press ‘n’.

A similar method can be used to produce letters with diacritical marks and other symbols:

To type any vowel with a circumflex above it:
Hold in Ctrl and Shift, press the 6/^ key, release all three keys and then type the vowel.

12.4.3 Smart quotation marks (smart quotes) vs. straight quotation marks (straight quotes)

Note the difference between straight quotation marks (‘…’ or "…") and smart quotation marks (‘…” or “…”): smart quotes are in the form of the numbers 6 and 9 respectively. Check that the type of quotation marks used in a document is used consistently.

To set a computer to use either straight or smart quotation marks automatically:

1. Click on Office in the top left-hand corner in MS Word 2007, or click on the File tab on the Office ribbon in MS Word 2010.
2. Then click on Word Options at the bottom of the menu, choose Proofing, and click on AutoCorrect Options > AutoFormat As You Type. (In MS Word 2003, click on Tools > AutoCorrect Options > AutoFormat As You Type.)
3. You will then be given the option to activate either straight or smart quotation marks. Make your choice and click on OK twice.
4. Do the same for AutoFormat.

12.5 Nonbreaking or hard space

Use a nonbreaking space between a number and a unit of measurement, for example an SI symbol, to ensure that the unit is not split up when a sentence runs on to the next line.

50 mg

Insert a nonbreaking space by clicking on the Insert tab and then on Symbol > More symbols on the far right.

OR:

1. Press Ctrl as well as Shift and hold them down.
2. Press the space bar.
12.6 Automatically spaced ellipsis

1. Click on **Office** in the top left-hand corner in MS Word 2007, or click on the **File** tab on the Office ribbon in MS Word 2010. Click on **Word Options** at the bottom of the menu, choose **Customize > Keyboard shortcuts > Customize OR Customize Ribbon > Customize Keyboard shortcuts.**

2. Scroll down in **Categories** to **Common Symbols.**

3. Scroll down and click **Ellipsis** in the right-hand column (**Common Symbols**).

4. Then, in the text block right below (**New shortcut key**), type the combination that you wish to set up to always generate an ellipsis (e.g. **Alt + Ctrl + .**). In future MS Office will insert an automatically spaced ellipsis every time you type this combination.

12.7 En dash and hyphen

12.7.1 Shortcut for the en dash on a desktop computer

1. Press the **Ctrl** key and hold it down.

2. Then press the minus sign (situated, as a rule, in the top right-hand corner of the keyboard, in line with the **Num Lock** key).

12.7.2 Nonbreaking hyphen

Sometimes MS Word automatically changes the suspended hyphen to the longer en dash. On some computers you can prevent this by inserting a nonbreaking hyphen:

1. Click on the **Insert** tab. Click on **Symbol > More Symbols > Special Characters > Nonbreaking Hyphen.**

OR

2. Use the keyboard shortcut **Ctrl + Shift + -** (the hyphen key, next to ‘0’ on the keyboard).

Always check that MS Word does not automatically change the hyphen’s length again once you have pressed the space bar or another key.

```
He was a two- or three-year-old.
```

12.7.3 Optional hyphen

It is possible with MS Word to insert optional hyphens in words.

Keyboard shortcut: **Ctrl + -** (the hyphen key – not the minus key – next to ‘0’ on the keyboard)

Unless MS Word is set to show paragraph signs, an optional hyphen that has been added will be visible as an ordinary hyphen only if the relevant word comes at the end of a line. Then the nonbreaking hyphen serves a word-break function. If a word with an optional hyphen is not at the end of a line, the hyphen remains hidden in printed versions of the text and in electronic versions if MS Word has been set to hide formatting symbols. If MS Word is set to show formatting signs, optional hyphens will be displayed as ‘¬’.
**NOTE:** Some layout programs do not render optional hyphens inserted in MS Word correctly. Adobe InDesign, for instance, replaces an optional hyphen with a single empty space. Therefore, use optional hyphens in an MS Word document only if you know that the document will not be finalised in a layout program.

### 12.8 Page numbers

#### 12.8.1 No page number on the first page

To keep the first page of a document unnumbered:

1. Click on the **Insert** tab and then on **Page Number**. Choose the position of the page number.

2. Click in the header or footer area of the first page to activate the **Design** tab. Then tick the checkbox for **Different First Page**. The page number on the first page will disappear.

3. To choose what the page number on the second page should be:

   3.a Click on the **Insert** tab and then on **Page Number > Format Page Numbers**. Ensure that the correct option at **Number Format** has been chosen.

   3.b Click on the **Start at** button at the bottom of the box and check that the correct number is displayed in the white block: ‘0’ (if you want the second page to start at 1) or ‘1’ (if you want the second page to start at 2).

   3.c Click **OK**.

#### 12.8.2 Mixed page numerals: the Roman and the Arabic systems

MS Word allows you to use Roman and Arabic numerals for separate sections within one document. The basic method can be used for various page-number combinations, but the instructions below are specifically for numbering the pages of a thesis correctly (i.e. the title page without any page number; the preliminary pages with page numbers displayed as Roman numerals, starting at ii; and the content from Chapter 1 onwards with page numbers displayed as Arabic numerals, starting at 1).

1. In order to see the spacing in the text clearly, go to the **Home** tab on the ribbon at the top, find the **Paragraph** group and click on the ¶ button (**Show/Hide**).

2. Scroll to the start of the thesis contents proper, where the first Arabic numeral (i.e. ‘1’) must appear, and click at the top of the page. Click on the **Page Layout** tab on the ribbon, go to the **Page Setup** group and click on **Break > Next Page**. The page before the intended page 1 will show a section break.

3. Click again at the top of the page to make sure that you are in the section of the document where the numbering must start at 1 (i.e. at the beginning of the thesis contents proper).
3.a Click on the **Insert** tab on the ribbon and then, in the **Header & Footer** group, on **Page Number > Format Page Numbers**. At **Number Format**, choose the option ‘1, 2, 3’.

3.b Click the **Start at** button at the bottom of the box and ensure that the white block shows ‘1’. Click **OK**.

3.c You should still be on the **Insert** tab. Click on **Page Number** again to choose the positioning of the page numbers. The first text page should now be numbered 1 and subsequent pages should follow on that (2, 3, etc.).

4. Go to the first page of the document that should show a Roman numeral (i.e. not the title page, but the next page, where the page number ‘ii’ should appear). Click at the top of this page, then click on the **Page Layout** tab on the ribbon, go to the **Page Setup** group and click on **Break > Next Page**. The title page will show a section break.

5. Click on the **Insert** tab on the ribbon and then, in the **Header & Footer** group, on **Page Number > Format Page Numbers**. At **Number Format**, choose the option ‘i, ii, iii’.

5.a Click the **Start at** button at the bottom of the same box and click the up arrow until the white block shows ‘ii’. Click **OK**.

5.b You should still be on the **Insert** tab. Click on **Page Number** again to choose the positioning of the page numbers. The second page should now be numbered ii and subsequent pages should follow on that (iii, iv, etc.).

6. The very first page will still show 1 in the header or the footer area. Click once in the relevant area to activate the **Design** tab. Click on **Design** and then on the checkbox next to **Different First Page**. The page number on the title page will disappear.

   If the page number on the title page does not disappear after **Different First Page** has been selected, double-click on the page number and delete it.

---

**TIP:** If the page numbers do not start at the desired number, go to the Insert tab and click on Footer in the Header & Footer group. Select Edit Footer on the drop-down menu. The Design tab should open. (Alternatively, follow the steps set out in the point above.) In the Navigation group, deselect Link to Previous. The page numbers should now do your bidding.
Works consulted


Works Consulted


University of Leicester. S.a. *Inclusive Writing Study Guide*. [Online]. Available: [http://www2.le.ac.uk/offices/ld/resources/writing/writing-resources/inclusive](http://www2.le.ac.uk/offices/ld/resources/writing/writing-resources/inclusive) [2013, September 2].


For further reading


Index

Abbreviations
Academic qualifications [3.3.1.1] ........................................................................................ 22
Addresses [2.3.1] ............................................................................................................... 15
Choice of indefinite article [3.1.11] ..................................................................................... 19
Foreign-language terms [3.2.3.1] ....................................................................................... 21
General rule [3.1.1] ............................................................................................................. 17
Hyphen use [3.1.4] ............................................................................................................. 17
Latin [3.1.7] ......................................................................................................................... 17
Months and days [3.1.9] ..................................................................................................... 18
Use of full stops [3.1.2] ...................................................................................................... 24
Academic writing, reference list in [10.2.2] ........................................................................ 74
Acronyms
Article use [3.1.10] .............................................................................................................. 18
Definition [3.2] .................................................................................................................... 20
Act (laws) names known under English abbreviation in other languages [11.2.3] ....... 78
Act (laws) titles and numbers, writing of [11.2.1] .............................................................. 77
Acts in a list of references [11.4] ........................................................................................ 72
Addresses
Abbreviations [2.3.1] ............................................................................................................. 15
Capitalisation [2.2.1] ........................................................................................................... 14
Offices or a building [2.1.2] ................................................................................................ 13
Punctuation [2.4] ................................................................................................................ 15
All-capitalised acronyms, plural form for [3.2.3.4] ............................................................ 21
American (US) English [1.1.1] .......................................................................................... 7
Antecedent use of pronouns [4.1.4] ........................................................................................................... 26
APA referencing system guidelines [10.3.6.1] ............................................................................................ 74
Apostrophe use in linked noun sets [8.2.10] ............................................................................................... 49, 50
Article use with acronyms [3.1.10] ........................................................................................................... 18
Article use with initialisms [3.1.10] ......................................................................................................... 18
Author’s choices, sensitivity when editing [1.3.4] ................................................................................... 11
Automatically spaced ellipses in MS Word [1.2.6] ..................................................................................... 85
British (UK) English [1.1.1] .................................................................................................................... 7

Bulleted lists
Consistency [7.1.1] ..................................................................................................................................... 42
Readability [7.1.1] ..................................................................................................................................... 42

Capitalisation
Academic subjects and disciplines [5.2.6] .................................................................................................. 33
Acronyms [3.2.2.1, 3.2.2.2] ......................................................................................................................... 20
Addresses [2.2.1, 2.2.2] .............................................................................................................................. 14
After colons [5.1.4, 8.3.1, 8.3.2] ................................................................................................................. 50
Compass directions [5.2.2] ......................................................................................................................... 32
Compound surnames [5.2.3] ...................................................................................................................... 32
Hyphenated words [5.1.3] .......................................................................................................................... 31
Job titles [5.3] .............................................................................................................................................. 34
Language Centre’s preference [5.1.2] ......................................................................................................... 31
Medical conditions and syndromes [5.2.7] ............................................................................................... 33
Titles of documents and other works [1.3.5] ............................................................................................. 11

Case law in reference list [11.5.1] .............................................................................................................. 79
Chapter names proper nouns in English [10.3.3 last bullet] .................................................................... 73
Collective nouns, subject-verb agreement [4.10] ....................................................................................... 30
Colons

Capitalisation with [5.1.4] .............................................................................................................. 31
Following capitalisation [8.3.1, 8.3.2]............................................................................................ 50
Linking words [8.3.3] .................................................................................................................... 50

Comments, the MS Word feature [12.3] .......................................................................................... 83
Compass directions, capitalisation of [5.2.2] .................................................................................... 32
Compound surnames, capitalisation of [5.2.3] ............................................................................... 32
Computer terms, as one or two words [1.1.5] ................................................................................... 8
Constitution of South Africa in reference list [11.4.2] .................................................................. 79
Contact person for the Style Guide ................................................................................................. v
Data, plural or singular [NOTE] ...................................................................................................... 30
Days of the week, abbreviation of [3.1.9] ....................................................................................... 18
‘disabled’ and ‘handicapped’, distinction between [6.6.4] .............................................................. 41
Dissertation, definition of [Sect. 10, introd. par.] ........................................................................... 65
Editing of academic writing, guidelines from client for [10.1.2] .................................................. 66
Editing of theses/dissertations

  Avoid rewriting [10.1.1].................................................................................................................. 66

  Guidelines from client [10.1.2] ..................................................................................................... 66

Editing options for theses/dissertations

  Comprehensive edit [Sect. 10, introd. par. option 1] ................................................................. 65

  Reference edit [Sect. 10, introd. par. option 3] ........................................................................... 65

  ‘Second-eye’ edit [Sect. 10, introd. par. option 2] ...................................................................... 65

En dash in MS Word [12.7.1] ......................................................................................................... 85
‘et cetera’ or ‘etc.’ [4.4] .................................................................................................................. 27
Figure titles proper nouns in English [10.3.3 last bullet] ............................................................... 73
Find, the MS Word feature [12.2] ................................................................................................... 82
‘firstly’ [4.5] .................................................................................................................................... 27
‘for example’ or ‘e.g.’ [4.4] .......................................................................................................... 27
Foreign-language abbreviations [3.2.3.1] ..................................................................................... 21
Page numbers in MS Word [12.8] .................................................................86
Arabic and Roman numerals in one document [12.8.2] .....................................86
Passive vs. active voice, consistency [1.3.4] ..........................................................11
People with disabilities, older proper names of institutions [6.6.2] .....................40
Personal pronoun, use of [4.1.2] .........................................................................25
Plain language [1.4, 6.1–2] ..................................................................................12
Plural form for initialisms and all-capitalised acronyms [3.2.3.4] .........................21
Preferred spelling (e.g. ‘e-mail’ vs. ‘email’) [1.2.1] .................................................8
Prepositions as indicators of location [2.1.6] .......................................................14
Pronoun use and inclusive language [4.1.1, 6.3–5] .................................................25
Provinces of South Africa, official names of [2.1.5] .............................................15
Publishers’ names, correct spelling of [1.1.4] .......................................................8
Punctuation – italicising, bolding or underlining [Sect. 8 introd. par.] ....................48
Punctuation in addresses [2.4] ...............................................................................15
Punctuation in lists [7.4] ......................................................................................45
Race, assumptions regarding – use of ‘African’ [6.5.5] .......................................40
Race descriptors, Stellenbosch University’s preference [6.5.3] .........................39
Referencing
  Academic writing [10.2.2, 10.3.6] ...............................................................66, 74
  Case law [11.5.1] .........................................................................................79
  Constitution of South Africa [11.4.2] ............................................................79
  Legislation [11.4.1] ......................................................................................78
Referencing systems in academic writing, guidelines from client [10.1.2] ...........66
Reflexive pronoun, use of [4.1.3] ........................................................................26
Reflexive verbs [4.1.3] ......................................................................................26
Research assignment, definition of [Sect. 10 introd. par.] .................................65
Singular plural [1.2.7] .......................................................................................9
Singular plural pronouns [4.1.1] .........................................................................25
Smart quotation marks vs. straight quotation marks [12.4.3] .............................84
Smart quotes vs. straight quotes [1.3.2] ..............................................................10
Spelling – British English vs. American English [1.1.1] .......................................................... 7
Stereotyping people in writing [6.1] .......................................................................................... 36
Street address [2.1.1, 2.1.3, 2.1.6, 2.2.1, 2.3, 2.4.1, 2.4.2] .................................................. 13
Sublevels of numbered lists [7.1.2 last bullet] ...................................................................... 43
Surnames, capitalisation of compound [5.2.3–4] .................................................................. 32
Syndromes, capitalisation of [5.2.7] .................................................................................. 33
Table captions proper nouns in English [10.3.3 last bullet] ............................................. 73
Tautology [1.2.2] .................................................................................................................... 8
Telephone numbers, correct form [2.5] ............................................................................. 16
‘that’ vs. ‘which’ [4.3] .......................................................................................................... 27

Theses/Dissertations

Blocked quotations [10.3.4 1st bullet on the page] ............................................................... 73
Comprehensive edit, editing option [Sect. 10 introd. par. option 1] ................................. 65
Direct quotations [10.3.4] .................................................................................................... 73
Editing checklist, after editing ............................................................................................. 76

Figures and tables

Numbering of [10.3.5 3rd bullet] ...................................................................................... 73
Placement [10.3.5 2nd bullet] ............................................................................................ 73
Titles of [10.3.5 1st bullet] .................................................................................................. 73
Figures, position of titles [10.3.5 last bullet] ..................................................................... 73
Font type and size [10.3.2] ............................................................................................... 72
Internet references in reference list [10.3.6.2 TIP] .......................................................... 75
Line spacing [10.3.2] .......................................................................................................... 72

Page numbering

Arabic and Roman numerals [10.3.1, 12.8.2] ..................................................................... 72
A range, hyphen or en dash [10.3.3 3rd bullet] .................................................................. 73
Preliminary pages

Abstract in Afrikaans [10.2.1 4th bullet & NOTE] ............................................................ 66
Abstract in English [10.2.1 3rd bullet & NOTE] .................................................................. 66
Acknowledgements [10.2.1 5th bullet] ............................................................................. 66
Appendices, position in table of contents [10.2.3] .......................................................... 72
Copyright note, prescribed wording Afrikaans [10.2.1.3] .................................................. 70
Copyright note, prescribed wording English [10.2.1.3] .................................................... 70
Declaration of originality, prescribed wording Afrikaans [10.2.1.2] ............................... 69
Declaration of originality, prescribed wording English [10.2.1.2] .................................... 70
Dedication [10.2.1 6th bullet] .......................................................................................... 66
List of abbreviations or acronyms after table of contents [10.2.1.4 last par.] ................. 71
List of figures and tables after table of contents [10.2.1.4 2nd last par.] ............................ 71
Order of elements [10.2.1] .............................................................................................. 66
Order of Afrikaans and English abstracts [10.2.1 NOTE] ................................................. 67
Reference list, position in table of contents [10.2.2] ......................................................... 72
Table of contents, automatically generated [10.2.1.4 NOTE] ......................................... 71
Table of contents, example of [10.2.1.4] ......................................................................... 70
Table of contents, numbering of [10.2.1.4] ..................................................................... 71
Title page [10.2.1.1] ........................................................................................................ 69
Title page, example ......................................................................................................... 68
Title page, prescribed wording Afrikaans [10.2.1.1] ........................................................ 69
Title page, prescribed wording English [10.2.1.1] ............................................................ 69
Title page, prescribed wording re supervisor [10.2.1.1 NOTE] ....................................... 69
Quotation marks, style of [10.3.3 1st bullet] ................................................................. 72
Quotations and references, guidelines from client [10.3.3 2nd bullet]............................... 72
Reference list, in which language [10.3.6.2 NOTE] .......................................................... 75
Reference edit, editing option [Sect. 10 introd. par. option 3] ........................................... 65
’sic’ [10.3.4 1st bullet] ....................................................................................................... 73
Tables, position of captions [10.3.5 last bullet] ............................................................... 73
Web addresses, line breaks in internet references [10.3.6.2 TIP] ..................................... 75
Thesis, definition of [Sect. 10 introd. par.] ...................................................................... 65
Time, indication of [1.3.1, 3.1.8] ...................................................................................... 10, 17
Titles of documents and other works, capitalisation of [1.3.5] ......................................... 11
Track Changes, the MS Word feature [12.1] ................................................................... 81
Vancouver referencing system guidelines [10.3.6.1] ......................................................... 74
Variety of English used [1.1.1–3] ....................................................................................... 7
‘which’ vs. ‘that’ [4.3] ....................................................................................................... 27
Wordiness [4.7] ............................................................................................................... 29